No part of this User's Manual may be copied, altered, or transferred to, any other media without written, explicit consent from R-tools Technology Inc.

All brand or product names appearing herein are trademarks or registered trademarks of their respective holders.

R-tools Technology Inc. has developed this User's Manual to the best of its knowledge, but does not guarantee that the program will fulfill all the desires of the user.

No warranty is made in regard to specifications or features.

R-tools Technology Inc. retains the right to make alterations to the content of this Manual without the obligation to inform third parties.
# Table of Contents

I Introduction to R-Linux  
1 R-Studio Features ........................................................................................................... 2  
2 R-Linux System Requirements .......................................................................................... 5  
3 Contact Information and Technical Support ..................................................................... 5  
4 R-Linux Main Panel .......................................................................................................... 6  
5 R-Linux Settings .............................................................................................................. 11  

II Data Recovery Using R-Linux  
1 Basic File Recovery .......................................................................................................... 17  
   Opening several partitions in one tab .................................................................................. 25  
   Searching for a File ............................................................................................................ 26  
   Finding Previous File Versions ....................................................................................... 28  
   Previewing Files .............................................................................................................. 29  
   File Masks ....................................................................................................................... 36  
   Regular Expressions ......................................................................................................... 37  
   Event Log .......................................................................................................................... 37  
2 Advanced Data Recovery ................................................................................................. 38  
   Disk Scan .......................................................................................................................... 38  
   Regions ............................................................................................................................ 46  
   Exclusive Regions ............................................................................................................ 47  
   Images ............................................................................................................................... 49  
3 Mass File Recovery ........................................................................................................... 53  
   Find and Mark Multiple Files ......................................................................................... 54  
   Recover Multiple Files ..................................................................................................... 55  
4 Various Disk and Volume Managers ............................................................................... 57  
   Linux mdadm RAIDs ....................................................................................................... 57  
   Linux LVM/LVM2 ........................................................................................................... 58  

III Text/Hexadecimal Viewer  
1 Viewing Objects .............................................................................................................. 60  
2 Navigating through an Object ......................................................................................... 61  
3 Data Copy ........................................................................................................................ 65  
4 Files and Sectors .............................................................................................................. 68  

IV Technical Information and Troubleshooting  
1 IntelligentScan Technology ............................................................................................. 70  
2 Data Recovery Issues ....................................................................................................... 71  
3 Data Formats and Multipliers ......................................................................................... 71  
4 Bad Sectors ....................................................................................................................... 72  
5 Memory Usage ................................................................................................................ 73  
6 R-Linux Switches ........................................................................................................... 74  
7 Properties Tab ................................................................................................................. 75  

© 2023 R-Tools Technology Inc.
I Introduction to R-Linux

R-Linux is a file recover utility for the Ext2/3/4FS file system used in the Linux OS and several Unixes. R-Linux uses unique IntelligentScan technology and flexible parameter settings to give you real control over the fastest data recovery ever seen. It recovers files from existing partitions even when file records are lost.

R-Linux is a lite version of more powerful file recover utility R-Studio. R-Studio utilizes the IntelligentScan technology to its full extent, and therefore can recover data from partitions with broken file systems. Also, R-Studio recovers data over network. To learn more about R-Studio, go to the R-Studio Features help page. To learn more about the IntelligentScan technology, go to the IntelligentScan help page.

R-Linux features:
- Standard "Windows Explorer" - style interface.
- Host OS: Linux, kernel 2.6 and above
- Supported file systems: Ext2/3/4FS (created by Linux or other OS).
- Support for known file types. R-Linux searches for files with known typical features of their structures allowing the user to search for files on devices with unknown files systems, including an HD, CD, DVD, floppy disk, Compact Flash Card, USB drive, ZIP drive, Memory Sticks, and other removable media.
- Scan process visualization. While scanning an object, R-Linux graphically shows items that have been found.
- Creates image files for an entire hard drive, partition, or its part. Such image files can be processed like regular disks. Images can be either simple exact object copies (Plain images) compatible with the previous versions of R-Linux, or compressed images that can be compressed, split into several parts, and password-protected. Such images are fully compatible with the images created by R-Drive Image, but incompatible with the previous versions of R-Linux. R-Linux can scan objects while creating their images.
- Recovers files on damaged or deleted partitions.
- Support for estimation of chances for successful recovery.
- Recovered files can be saved on any (including network) disks visible by the host operating system.
- Support for Linux mdadm Volumes
- Support for Linux LVM/LVM2
- A hexadecimal disk and file viewer.
- Patterns (or templates) in the hexadecimal viewer allowing for parsing the data according to specific data structure. Such patterns may be custom-created.

R-Linux recovers files:
- Removed by virus attack or power failure;
- After the partition with the files was reformatted, even for a different file system;
- When the partition structure on a hard drive was changed or damaged. In this case, R-Linux can scan the drive trying to find previously existed partitions and recover files from found partitions.
- From disks with bad sectors. In this case, R-Linux can first copy the entire disk or its part into an image file and then process such image file.

R-Linux can create image files for an entire hard drive, partition, or its part. Such image files can be processed like regular disks. Images are very useful if there is a risk of total data loss due to hardware
malfunction. If bad blocks are constantly appearing on a hard drive, the only way to save the data is to immediately create an image of that drive. All data search, scan and recovery can be done from this image.

R-Studio Features
System Requirements
Contact Information and Technical Support
Data Recovery Using R-Linux
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Text/Hexadecimal Viewer
Technical Information and Troubleshooting

1.1 R-Studio Features

R-Studio is a family of file restoring utilities. It recovers files both on local disks and on disks on remote computers over network, even if their partition structures are damaged. A unique IntelligentScan technology and flexible parameter settings give you real control over the fastest data recovery ever seen.

R-Studio for Linux features:
- Host OS: Linux, kernel 2.6 and above.
- Automatic check for updates.
- Remotely recovers data over network. Data can be recovered on network computers running Windows, Mac, and Linux and some other UNIX OS.
- Supported file systems:
  - Windows: FAT12, FAT16, FAT32, exFAT, NTFS, NTFS5, ReFS/ReFS2+ file (Resilient File System); ReFS for Windows Server 2019 (including deduplication).
  - macOS: HFS, HFS+, HFSX, APFS, FAT/exFAT;
  - Linux and UNIX: Ext2/3/4FS and XFS (created by Linux or other OS), and UFS1, UFS2, UFS BigEndian (used by the FreeBSD, OpenBSD, and NetBSD operating systems);
  - CD/DVD/Images: ISO9660;
  - Magnetic tape devices: UStar/Tar/CPIO/Pax (R-Studio Technician/T80+).

Please note, that when a file is being deleted on the HFS, HFS+, HFSX file systems, the computer completely removes all system information on it, and there is no way to recover the deleted file except by using the Extra Search for Known File Types option. Nevertheless, R-Studio for Linux is able to read existing files from HFS, HFS+, and HFSX disks.

- Support for known file types. R-Studio for Linux searches for files with known typical features of their structures allowing the user to search for files on devices with unknown file systems, including an HD, CD, DVD, floppy disk, Compact Flash Card, USB drive, ZIP drive, Memory Sticks, and other removable media.
- Scan process visualization. While scanning an object, R-Studio for Linux graphically shows items that have been found, including files of known types, FAT and NTFS MFT records, boot records, etc.
- Mass file recovery support.
- Support for estimation of chances for successful recovery.
- Support for file recovery lists - lists of files that can be exported from R-Studio for Linux, manually edited, and then loaded back. Files from such lists will be automatically marked for recovery.
• APM, Basic and GPT support. **R-Studio for Linux** supports all three partition schemes used to define the low-level organization of data on disks [formatted](#) for use with Macintosh computers.

• Support for **Linux mdadm Volumes**

• Support for **Linux LVM/LVM2**

• **Dynamic disk** support.

• Software RAID, volume set, and stripe set support. Support for RAID 6, RAID 5, and RAID 4 layouts. Support for custom RAID layouts. Parameters like block size and order, offsets, and even the number of stripe blocks can be explicitly specified. Custom RAID configurations can be saved.

• Support for **Windows Storage Spaces**, created by Windows 8/8.1 and Windows 10/Threshold 2/Anniversary/Fall Creators updates.

• Support for **Apple software RAIDs**

• Support for **Apple CoreStorage/FileVault/Fusion Drive Volumes**

• Support for Intel Software RAID.

• Hardware RAID, volume set, and stripe set support.

• RAID consistency check (check for valid data parity values).

• Automatic RAID parameter recognition.

• Creates image files for an entire drive, **logical disk**, or its part. Such image files can be processed like regular drives. Images can be either simple exact object copies (Plain images), compatible with VmWare Virtual Machine disks (in the **Technician/T80+** version), or **R-Drive Image** compatible that can be compressed, split into several parts, and password-protected. Images may be saved either on the local or remote computer. Image creation can be stopped and then resumed. **R-Studio for Linux** can scan objects while creating their images. **R-Studio Technician/T80+** supports multi-pass and runtime imaging. Images can be mounted in the operating system as devices which makes their content accessible to any program including any other data recovery software.

• Creates image files for an entire hard drive, logical disk, or its part. Such image files can be processed like regular disks. Images can be either simple exact object copies (Plain images) compatible with the previous versions of **R-Studio for Linux**, or compressed images that can be compressed, split into several parts, and password-protected. Such images are fully compatible with the images created by **R-Drive Image**, but incompatible with the previous versions of **R-Studio for Linux**. Images may be saved either on the local or remote computer. **R-Studio for Linux** can scan objects while creating their images.

• Recovers files on damaged or deleted partitions.

• Recovers compressed files (NTFS, NTFS5).

• Recovers encrypted files (NTFS5).

• Recovers alternative data streams (NTFS, NTFS5).

• Support for NTFS deduplication.

• Support for **symbolic links**. Symbolic link recovery options in the Technician version.

• Support for file system journal on the HFS+ and Ext3/4fs file systems.

• Support for soft updates journal on the UFS file system.

• Support for extended attributes on the HFS+, Ext3/4fs, and UFS file systems.

• Support for compressed files on the HFS+ file system.

• Recognizes localized names.

• Recovered files can be saved on any (including network) disks visible to the host operating system.

• A hexadecimal disk and file viewer/editor supporting NTFS file non-resident attribute editing. Data alteration is available on the **Technician/T80+** version only.
• Patterns (or templates) in the hexadecimal editor allowing for parsing the data according to specific data structure. Such patterns may be custom-created.
• File preview. Most of the file types can be previewed to estimate recovery chances.
• Enhanced remote host scanning procedure. In the new R-Studio for Linux network versions, data are analyzed on the remote host rather than on the home host, thereby the speed of recovery procedure greatly increases.
• Recovered files may be saved on a disk on a connected remote computer rather than be transferred over network to the local one. Saving recovered files on a remote computer may be useful when the remote computer has a healthy disk because you do not have to transfer files over network. It may be an external USB hard drive, for example.
• R-Studio Emergency*. The R-Studio for Linux Emergency version starts from a floppy or compact disk when it is necessary to recover data on a computer, on which OS cannot start up because its system files are corrupted or deleted.

*The R-Studio Emergency is a part of the R-Studio for Linux software package. When you buy an R-Studio for Linux single license you may run the R-Studio Emergency or/and install the R-Studio for Linux Windows version on one PC only and you may not transfer the licensed software to another PC.

R-Studio features available in the Technician/T80+ versions:
• Magnetic tape devices file system: UStar/Tar/CPIO/Pax.
• Extended file information
• Symbolic link recovery options
• Drive Copy Wizard to copy any object in the Drives panel to any other object. In addition to byte to byte copy of any object visible in the Drives panel, smart copy of partitions and drives is available.
• I/O Monitor and Sector Map files.
• Multi-pass and Runtime imaging
• Reverse RAIDs: A technique that decomposes real drive objects into virtual RAIDs. Then those components of reverse RAID scan be processed like real objects. They can be viewed, edited, imaged, copied to physical
• Support for third-party hardware.
• Forensic mode.
• File recovery over Internet.

R-Studio for Linux recovers files:
• That have been removed without the Recycle Bin, or when the Recycle Bin has been emptied;
• Removed by virus attack or power failure;
• After the partition with the files was reformatted, even for a different file system;
• When the partition structure on a hard drive was changed or damaged. In this case, R-Studio for Linux can scan the drive trying to find previously existed partitions and recover files from found partitions.
• From disks with bad sectors. In this case, R-Studio for Linux can first copy the entire disk or its part into an image file and then process such image file.

R-Studio for Linux can create image files for an entire hard drive, logical disk, or its part. Such image files can be processed like regular disks. Images are very useful if there is a risk of total data loss due to hardware
malfunction. If bad blocks are constantly appearing on a hard drive, the only way to save the data is to immediately create an image of that drive. All data search, scan and recovery can be done from this image.

To learn more about the *IntelligentScan* technology, go to the *IntelligentScan* topic.

### 1.2 R-Linux System Requirements
- An Intel-compatible x86 or 64-bit platform with 32 MB RAM, a mouse, and enough disk space for recovered files, image files, etc.
- Linux: Fedora 12+, Ubuntu/Kubuntu 10.4+, Debian 4.0+ or any kernel 2.6+ Linux distribution capable of installing .rpm or .deb packages.
- Any Window manager.
- X.Org X server 1.7.6+ installed.
- Root privileges to install and run the program.

### 1.3 Contact Information and Technical Support
To obtain the latest version of **R-Linux**, go to:
- Product Site: [http://www.r-tt.com](http://www.r-tt.com)
- Sales Department: sales@r-tt.com

**R-Linux** Technical Support Team is available 24 hours a day, seven days a week, and has an average response time less than 4 hours.
- Tech. Support: support@r-tt.com
- Send your support request to: [http://www.r-tt.com/SupportRequest.shtml](http://www.r-tt.com/SupportRequest.shtml)

R-tt Forum: [http://forum.r-tt.com](http://forum.r-tt.com)
1.4 R-Linux Main Panel

When R-Linux starts, its main panel appears on the desktop.

**R-Linux Main panel**

**Drives panel:**

can select an object by clicking on it.
Properties tab:

This tab shows the properties of an object selected on the Drives panel.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Type</td>
<td>Physical Drive/Block</td>
</tr>
<tr>
<td>OS</td>
<td>Windows</td>
</tr>
<tr>
<td>RAID Status</td>
<td>Online</td>
</tr>
<tr>
<td>Size</td>
<td>500 GB</td>
</tr>
<tr>
<td>Logical Sector Size</td>
<td>512 bytes</td>
</tr>
<tr>
<td>Physical Sector Size</td>
<td>512 bytes</td>
</tr>
<tr>
<td>Sector Number</td>
<td>1024</td>
</tr>
<tr>
<td>Block Size</td>
<td>512 bytes</td>
</tr>
<tr>
<td>Buffer Alignment</td>
<td>4 KB</td>
</tr>
<tr>
<td>Physical Drive Geometry</td>
<td></td>
</tr>
<tr>
<td>Cylinders</td>
<td>5000</td>
</tr>
<tr>
<td>Tracks Per Cylinder</td>
<td>100</td>
</tr>
<tr>
<td>Sectors Per Track</td>
<td>1000</td>
</tr>
<tr>
<td>Sector Size</td>
<td>512 bytes</td>
</tr>
<tr>
<td>RAID Level</td>
<td>0</td>
</tr>
<tr>
<td>Device ID</td>
<td>0x10000002</td>
</tr>
<tr>
<td>Firmware</td>
<td>1.01</td>
</tr>
<tr>
<td>Model</td>
<td>LS121</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>ST EC</td>
</tr>
<tr>
<td>Part Number</td>
<td>LSD7112S</td>
</tr>
<tr>
<td>Model Number</td>
<td>000000</td>
</tr>
</tbody>
</table>

Depending on the selected object, information on this Properties tab may vary.

The Properties tab names and values are described in detail on the Properties tab topic.

Log window:

S.M.A.R.T. Info for a Hard Drive

R-Linux shows hard drive S.M.A.R.T. states using their icons. You may copy all S.M.A.R.T. attributes and paste them into a text editor.

- **Hard drive S.M.A.R.T. states and icons**

Normal: This state indicates that the hard drive is in good conditions.
Warning: This state indicates that some small problems with the disk are possible in the future, you may work with it but with cautions and regular check of these parameters. Disk imaging is strongly recommended.

Critical: This state indicates that the hard drive conditions are critical and chances of hardware failure are great. The best recommendation for this case is to stop working with the disk and bring it to professional data recovery specialists. You may though continue to work with the disk at your own risk, but disk imaging is very strongly recommended.

When a hard drive is selected on the R-Linux main panel, an additional S.M.A.R.T. tab will appear. You may view the detailed S.M.A.R.T. data of the drive.
S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a technology widely-used in hard drives and solid-state devices that monitors their reliability conditions to predict possible hardware failures.

Changing the program language
You may select the language of R-Linux main panel. To do so, select an available language on Change Language on the Help menu

Panel view options
You may set which panels and bars to enable/disable.

To enable/disable:

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Select/clear Toolbar on the View menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status bar</td>
<td>Select/clear Status bar on the View menu</td>
</tr>
<tr>
<td>Drive pane</td>
<td>Select/clear Device View on the View menu</td>
</tr>
<tr>
<td>Properties pane</td>
<td>Select/clear Properties View on the View menu</td>
</tr>
<tr>
<td>Log panel</td>
<td>Select/clear Event Log on the View menu</td>
</tr>
</tbody>
</table>

If you have several tabs in the right pane, you may easily switch to any of the tab by selecting on the View menu

<table>
<thead>
<tr>
<th>Properties Tab</th>
<th>to view the Properties tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Information Tab</td>
<td>to view the Scan Information Tab tab</td>
</tr>
<tr>
<td>Parents Tab</td>
<td>to view the Parents tab</td>
</tr>
<tr>
<td>Properties</td>
<td>Select data types in which the data will be represented</td>
</tr>
</tbody>
</table>

Sometimes, there may be a lot of similar objects on the Drives panel. Those may be components of a RAID, for example. You may turn numerical indexes for such objects to distinguish them better. Those indexes will appear before the object names on the Drives panel.

To turn the numerical indexes on/off, go to the Device item on the View menu, and select/clear:

Show Physical Drives Indexes to display the indexes only for hard drives
Show All Objects Indexes to display the indexes for all objects on the Drives panel

You may select the units in which object’s start and size are displayed

To select the units
1 Select Devices on the View menu
2 Select the units in which you want to see object sizes.
   You may select
   Show as Bytes
   Show as Sectors
   Show as Bytes and Sectors
Depending on the task R-Linux performs, its panel may vary. Those panels are described in appropriate topics. The Properties tab names and values are described in detail on the Properties tab topic.

**Refresh**
Click this button to refresh the panels.

**Show Files**
Click this button to start searching for files on a selected object.

**Scan**
Click this button to start scanning a selected object.

**Open Image**
Click this button to open a previously created image.

**Create Image**
Click this button to create an image of a selected area.

**Create Region**
Click this button to create a region on a selected disk.

**Remove**
Click this button to delete a selected object on the main panel.

**Stop**
Click this button to stop the current operation.

You may also copy the object's information displayed on the Drives panel. Right-click the object on the necessary column and select Copy Device/Disk, Copy Label, and so on.

**R-Linux has two operation modes:**

**File search** on a partition (including recently found during disk scan).

In this mode, R-Linux analyzes data on the partitions. Then it displays all files which records have been found in the analyzed tables. Then recently deleted files, which records still remain, can be recovered. If files have not been found, that means that their records have been deleted. In this case, the disk must be scanned.

File search supports file masks and regular expressions. Multiple files in different folders can be found and recovered in one recover session.

**R-Linux** supports mass file recovery. There is no limit in the number of files that may be recovered during one session.

File content may be previewed before recovery.

File or disk binary data can be viewed in the Text/Hexadecimal Viewer. Also can be viewed and changed all attributes for NTFS files.
Disk scan, searching for partitions.

In this mode, R-Linux scans the entire disk or its part. Using a number of statistic and deterministic criteria known as IntelligentScan technology, it determines existing or existed partitions on the disk, and their file systems. It is also possible to add new partitions, by setting manually all required parameters.

A disk can be scanned through several successive scans, each with its own parameters. R-Linux accumulates the information from successive scans and keeps track of changes in the information obtained from different scans. The information obtained from the disc scan can be stored in a file. It may be loaded and processed later at any convenient time.

1.5 R-Linux Settings

You may specify some global setting for R-Linux on the Settings dialog box. You may reach it by selecting Settings on the Tools menu.

Main

Main dialog box

Main settings

<table>
<thead>
<tr>
<th>System Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-refresh Drive Tree</td>
<td>If this box is selected, R-Linux automatically refreshes the list of connected disks. You may disable it if R-Linux experiences problems with connected devices.</td>
</tr>
<tr>
<td>Debug Mode</td>
<td>If this check box is selected, R-Linux displays an additional command Create FS Snapshot on the shortcut menu for an object with a file system. An FS Snapshot contains system data for the file system only (file descriptions without file contents). If a problem appears, this snapshot can be sent to R-Linux technical support to identify the problem. This option greatly slows R-Linux.</td>
</tr>
<tr>
<td>Check for update</td>
<td>If this box is selected, R-Studio will automatically check for updates.</td>
</tr>
</tbody>
</table>

Notifications

Reset all hidden notifications.

Click this button to enable all previously disabled notification messages.

User’s file mask presets

File name: Specifies a file name and path to the file with file mask presets.
**File Systems**

**Dialog box**

![File Systems dialog box](image)

**Default encoding for Ext2/Ext3/Ext4 volumes**
Select the national encoding for the Ext2, Ext3, and Ext4 partitions.

**Disable any sorting**
Select this option if the number of files on the disk is so large that R-Linux sorts files in selected folders for too long time.

**Minimize disk access**
Select this option if a lot of bad sectors are on the hard drive. R-Linux will reduce access to internal files in the file system to speed up the interpretation of file system data.

**Show deleted empty folders**
Select this option if you want to view empty deleted folders.

**Log**

**Log dialog box**

![Log dialog box](image)

**Log options**

<table>
<thead>
<tr>
<th>Log options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logging</strong></td>
<td>Specifies the maximum number of messages R-Linux will keep in the event log</td>
</tr>
<tr>
<td><strong>Save log to file</strong></td>
<td>If this check box is selected, R-Linux writes its log into a log file specified in the File name field.</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>Specifies the file name in which the log will be saved.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>If this check box is selected, R-Linux logs all events with recovered files.</td>
</tr>
<tr>
<td><strong>File System</strong></td>
<td>If this check box is selected, R-Linux logs all events with the file system.</td>
</tr>
<tr>
<td><strong>Partition</strong></td>
<td>If this check box is selected, R-Linux logs all events with partitions.</td>
</tr>
</tbody>
</table>
### Recover
If this check box is selected, **R-Linux** logs all events with the recovering processes.

### Disk
If this check box is selected, **R-Linux** logs all events with disks.

### Network
If this check box is selected, **R-Linux** logs all events with network operation.

### Severity

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>If this check box is selected, <strong>R-Linux</strong> adds error messages into its log.</td>
</tr>
<tr>
<td>Warning</td>
<td>If this check box is selected, <strong>R-Linux</strong> adds warning messages into its log.</td>
</tr>
<tr>
<td>Information</td>
<td>If this check box is selected, <strong>R-Linux</strong> adds information messages into its log.</td>
</tr>
<tr>
<td>Success</td>
<td>If this check box is selected, <strong>R-Linux</strong> adds success messages into its log.</td>
</tr>
</tbody>
</table>

**NEVER WRITE A LOG FILE ON THE DISK FROM WHICH YOU RECOVER DATA!!!**
Or you may obtain unpredictable results and lose all your data.

**Note:** If in the **Recover** dialog box the Condense successful restoration events check box is selected, the **Log** will display only Error, Warning, and Information event messages.

### Known File Types

**Known File Types** dialog box

You may specify which **Known File Types** will be enabled/disabled by default. You may also specify know file types to search for during a specific scan session on the **Scan** dialog box.
Known File Types

- **Reset**: Click this button to reset the settings to the previous state. Active until the **Apply** button is clicked.
- **Select All**: Click this button to select all file types in the list.
- **Clear All**: Click this button to clear all file types in the list except some predefined ones.
- **Reload User's File Types**: Click this button to apply new file types after the user's file types file has been changes from the Main tab.

Bad Sectors

**Bad Sectors dialog box**

![Bad Sectors dialog box]

**Bad Sectors settings**

- **Default read retries**: Specifies a default value for I/O Tries, or how many times **R-Linux** will try to read a bad sector. You may specify this parameter for each drive separately on the **Properties** tab.

  **R-Linux** treats bad sectors in the following way:

  It reads a certain part of disk (predefined by Windows) and
  - If Default read retries is set to 0, the entire part with bad sectors will be filled with the specified pattern.
  - If Default read retries is set to a non-zero value, **R-Linux** reads again that part sector by sector, repeating the attempts the specified number of times. If **R-Linux** still cannot read a bad sector, it fills the sectors with the specified pattern. In this case only the bad sectors will be filled with the pattern, but that extremely slows the disk read process.

  For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

- **Set for all drives**: Click this button to reset I/O Tries for all drives to the default value.
- **Pattern to fill bad blocks**: Specifies a default pattern **R-Linux** will use to fill bad sectors in files to recover, in images, or when showing data in the **Text/Hexadecimal Viewer**. You may specify the pattern either in the ANSI or Hex data format.

  **Note**: **R-Linux** will never ever try to write anything on the disk from which data is to recover or an image is to create.

Memory Usage

**Memory Usage dialog box**
These settings control how much memory **R-Linux** uses for its work. They help preventing **R-Linux** from locking when trying to perform very memory-consuming tasks like scanning large disks or processing file systems with a lot of files.

**Memory Usage settings**

<table>
<thead>
<tr>
<th>Disable memory control</th>
<th>If this option is selected, the memory control is disabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>If this option is selected, <strong>R-Linux</strong> will automatically stop performing the task when the amount of used memory reaches the specified value. You may specify the limit for either the virtual or physical memory.</td>
</tr>
</tbody>
</table>

You may see how much memory **R-Linux** actually uses on the **Memory Usage** dialog box.
II Data Recovery Using R-Linux

Depending on the situation, data recovery may vary:

1. **Recovery of deleted files that have resided on an existing partition**
   
   This can be done using Basic File Recovery.

2. **Recovery of files that have resided on a data disk with a damaged file system, or on a previously deleted or re-formatted partition**
   
   If the file system on such partition is damaged, the operating system sees that partition as a partition without a valid file system. Such partition should be previously scanned. Also, it should be scanned if you want to recover data on a previously deleted or re-formatted partition.

   When the partition is scanned, a number of recognized partitions will appear. R-Linux shows them in different colors depending on which elements of the partition have been found.

<table>
<thead>
<tr>
<th>Partition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>An existing partition</td>
<td></td>
</tr>
<tr>
<td>An existing partition after disk scan</td>
<td></td>
</tr>
<tr>
<td>Both boot records and file entries are found for this partition</td>
<td></td>
</tr>
<tr>
<td>Only file entries are found for this partition</td>
<td></td>
</tr>
<tr>
<td>Only boot records are found for this partition</td>
<td></td>
</tr>
<tr>
<td>A deleted partition</td>
<td></td>
</tr>
<tr>
<td>Empty space on the object</td>
<td></td>
</tr>
<tr>
<td>Files that have been found using scan for known file types</td>
<td></td>
</tr>
</tbody>
</table>

   Although such recognized partitions are virtual objects, files can be searched for and recovered from recognized partitions as from real partitions using Basic File Recovery.

   To successfully recover files from a recognized partition, it is necessary to find a right one which corresponds to the real partition on which the files resided. No strict rules can be applied to that, but the following considerations should be taken into account:

   - If you are going to recover files from a **disk with a damaged file system**, most likely the right recognized partition will be a green one.
   - If you are going to recover files from a **previously deleted or re-formatted partition**, most likely the right recognized partition will be a yellow one.

   Also always check the recognized partition's file system, start point, and size. They should be the same for the recognized partition and real partition. When in doubt, try to preview a couple of files from the recognized partition. If the files are seen correctly, this is the right partition.

R-Studio Features

Contact Information and Technical Support

Basic File Recovery

Advanced Data Recovery

Mass File Recovery

Various Disk and Volume Managers

Text/Hexadecimal Viewer

Technical Information and Troubleshooting
2.1 Basic File Recovery

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS ON THE SAME PARTITION WHERE THEY RESIDE!!!

Or you may obtain unpredictable results and lose all your data.

Basic file recovery can be made for deleted files that has resided on an existing partition visible to the operating system. In all other cases, Advanced Data Recovery is required.

To recover deleted files from an existing or recognized partition,

1. Double-click a partition on the R-Linux’s Drives panel to enumerate files on the disk

   Other ways to enumerate files
   - Select the disk and click the Show Files button, or
   - Right-click the selected disk and select Open Drive Files on the context menu, or
   - Select Open Drive Files on the Drive menu

   If you try to enumerate files on a hard drive or another object without a valid file system on it, a message will appear. Select a partition on the object or scan the object.

   > R-Linux will change its panel showing the disk’s folders/files structure

   R-Linux analyzes data on the object and displays all files for which records have been found in the analyzed tables. If files have not been found, that means that their records have been deleted. To find such files, Advanced Data Recovery is required.

   Please note that R-Linux shows only those files/folders that match a specified file mask.

   R-Linux Main panel
Panel view options
You may set which panels and bars to enable/disable. To enable/disable

<table>
<thead>
<tr>
<th>The Toolbar</th>
<th>Select/clear Toolbar on the View menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Status bar</td>
<td>Select/clear Status bar on the View menu</td>
</tr>
<tr>
<td>The Folders panel</td>
<td>Select/clear Folders View on the View menu</td>
</tr>
<tr>
<td>The Files panel</td>
<td>Select/clear Contents View on the View menu</td>
</tr>
<tr>
<td>The Log panel</td>
<td>Select/clear Event Log on the View menu</td>
</tr>
<tr>
<td>The Find Results panel</td>
<td>Select/clear Find Results on the View menu</td>
</tr>
</tbody>
</table>

You may also arrange the data as required. On the View menu, select Arrange and then a required arrangement.

You may specify which columns will be visible on the Files panel. On the View menu, select Contents Columns, and select the columns you want to see.

Files can be shown as a list or as icons/tiles of different sizes.

Files shown as icons/tiles

Recovery chances
R-Linux shows its estimates of chances for successful file recovery in the Rec column.

Recovery chances
- Undefined
- Good
- Above average
- Average
- Below average
- Bad

When R-Linux has enumerated files, those estimates may not be accurate and aren't available for most files. You may improved them by right-clicking any folder on the Content pane and selecting Recheck Recovery Chances on the context menu.
The best estimations are though after scanning the disk/partition.

**File Information**
You may view some information about a file. Right-click the file and select **Get Info** on the context menu.

**File Information**

Click this button to pin the file information. This panel will show the information about the "pinned" file regardless of the current selected file.

Click this button to copy all this information

Click this button to select the file you want to go to.

Click this button to close all the information.
### Folders panel
- **Deleted folder**
- **Marked folder** (all child objects in this folder are marked)
- **Partially marked folder** (some child objects in this folder are marked)

**Extra Found Files** folder

**Log panel**

**Files panel:**
- **Deleted file:**
- **Marked deleted file**
- **Selected deleted file**
- **Target of a hard link**
- **Hard link to a file**

### Find Results panel

**Reopen All Files**
Click this button to list files again.

**Recover**
Click this button to recover selected folders/files.

**Recover Marked**
Click this button to recover marked folders/files.

**Find**
Click this button to find a particular file/folder.

**Find Next**
Click this button to find the next object specified in the Find dialog window.

**Find Previous**
Click this button to find the previous object specified in the Find dialog window.
File Mask
Click this button to specify a file mask.

The **Unmask** button appears when a mask is applied.
Click this button to remove the applied mask.

**Up**
Click this button to move highlighting one folder up.

**Options**
Click this button to change Recovery Options.

**Stop**
Click this button to stop the current operation.

The **Log** panel will show how many files and folders are on the object, and their size. You may specify which events will be shown in the log pane by setting a log filter.

**Note:** Metafiles are the file system's internal files invisible to any user, or file system data, which **R-Linux** represents as files. These files do not contain user data directly. Unless you want to scrutinize a disk file system, do not restore them.

If the **Too many files...** message appears, you may temporarily stop file listing and browse through found files. Then you can resume file listing. You also may skip this file topic and continue. **R-Linux** will keep information about the entire file structure.

**You may also copy the information about folders and files.**

**For the folder (the Folders pane):**

<table>
<thead>
<tr>
<th>Click <strong>Copy Folder:</strong></th>
<th>To copy the folder's name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Copy Path:</strong></td>
<td>To copy the path to the folder</td>
</tr>
</tbody>
</table>

**For the file (the Contents pane):**

<table>
<thead>
<tr>
<th>Click <strong>Copy (Column Name):</strong></th>
<th>To copy the file's <strong>Name</strong>, <strong>Size</strong>, <strong>Created</strong>, etc., depending on which column is selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Copy Path:</strong></td>
<td>To copy the file path.</td>
</tr>
<tr>
<td>Click <strong>Copy Selected Text:</strong></td>
<td>To copy all the columns of the selected file.</td>
</tr>
</tbody>
</table>

2 **Select a file/folder to recover**

You may select several files/folders in the same parent folder by pressing the **Shift** button and clicking the objects simultaneously.

**Marking multiple files/folders from different parent folders manually:**
Mark a file/folder to recover by clicking the box left to the object, or select **Mark** on the context menu.

You may mark several files/folders in different parent folders. You may mark all objects in the folder by selecting **Mark All** on the **Tools** or context menu. To unmark an object, click the box left to the object.
once more or select **Unmark** on the context menu. You may unmark all objects in the folder by selecting **Unmark All** on the **Tools** or context menu.

The **Log** panel will show how many files and folders you have marked, and their total size. **R-Linux** can search for a particular file. Go to the **Searching for a File** topic for details. If you need to find and mark many files, go to the **Find and Mark Multiple Files** topic for details.

File content may be previewed before recovery. Go to the **Previewing Files** topic for details.

**If you do not find files that you want to recover:**

Sometimes **R-Linux** can find the files but not the entire file paths to them. It puts such files into the **Extra Found Files** folder. Try to search for the files there. If that does not help, try to find them by using file search globally on the entire disk. Go to the **Searching for a File** topic for details.

If you still cannot find files that you want to recover but are sure they have existed on the logical disk, you need to use **Advanced Data Recovery** to find them.

3 **Click the Recover or Recover Marked button**

**Other ways to recover selected files**

- Right-click the selected file/folder and select **Recover** or **Recover Marked** on the context menu,
- Select **Recover** or **Recover Marked** on the **File** menu

4 **Specify recover options and output folder on the Recover dialog box and click the OK button**

**Recover dialog box**

<table>
<thead>
<tr>
<th><strong>Recover options</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condense successful restoration events</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers the folder structure in which all files to recover reside starting from the common topmost folder.</td>
</tr>
<tr>
<td>Restore folder structure</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers the entire path to the selected object.</td>
</tr>
<tr>
<td>Restore from root</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers the entire path to the selected object starting from the root folder of the disk.</td>
</tr>
<tr>
<td>Recover real folders structure</td>
<td>Enabled when the files are sorted by their extensions or date. See <strong>Find and Mark Multiple Files</strong> for details. If this check box is selected, <strong>R-Studio</strong> recovers the real folders/files structure on the disk rather than that of sorted files.</td>
</tr>
</tbody>
</table>
Data Recovery Using R-Linux

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recover metafiles</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers disk metafiles. Metafiles are the file system's internal files invisible to any user, or file system data, which <strong>R-Linux</strong> represents as files. These files do not contain user data directly. Unless you want to scrutinize a disk file system, do not restore them.</td>
</tr>
<tr>
<td>Recover alternative data streams</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers alternative data streams for file systems that support them.</td>
</tr>
<tr>
<td>Recover security</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers security attributes for NTFS files. Has no effect on FAT files.</td>
</tr>
<tr>
<td>Recover extended attributes</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers extended (HPFS) file attributes.</td>
</tr>
<tr>
<td>Skip files with bad sectors</td>
<td>If this check box is selected, <strong>R-Linux</strong> skips files with bad sectors and displays their list on the <strong>Files with bad sectors</strong> dialog box when the recovery has been completed. You may separately decide later what to do with those files. See <strong>Bad sectors</strong> for details. If this check box is cleared, <strong>R-Linux</strong> tries to read those sectors several times (specified on the <strong>Settings/Bad Sectors</strong> dialog box), and, if fails, fills bad sectors in the recovered file with the pattern specified on the same box. Information about such files will appear in the <strong>Log</strong>.</td>
</tr>
<tr>
<td>Do not recover duplicate files from Extra Found Files</td>
<td>If this check box is selected, <strong>R-Linux</strong> does not recover files from Extra Found Files (raw files) that coincide with files recovered from the file system.</td>
</tr>
<tr>
<td>Ignore file mask</td>
<td>If this check box is selected, <strong>R-Linux</strong> recovers all content of a selected folder, ignoring a specified <strong>File Mask</strong>.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Specifies options for <strong>mass file recovery</strong></td>
</tr>
</tbody>
</table>

If you want to recover multiple files at once, go to the **Recover Multiple Files** for more information.

**NEVER TRY TO SAVE RECOVERED FILES/FOLDERS ON THE SAME PARTITION WHERE THEY RESIDE!!!**

**Or you may obtain unpredictable results and lose all your data.**

If a file to be recovered appears to have an invalid name, a **Broken File Name** dialog box will appear. You may correct the name and resume file recovery.

**Broken File Name dialog box**

![Broken File Name dialog box](image)

**Broken File Name properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Shows the current incorrect file name.</td>
</tr>
<tr>
<td>New name</td>
<td>Field for a new file name.</td>
</tr>
</tbody>
</table>
> **R-Linux** will recover the selected/marked files/folders to the specified folder and show the results in the Log pane.

The **Recovery progress** indicator will show the log and progress of recovery process.

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Click to resume file recovery</td>
</tr>
<tr>
<td>Rename All</td>
<td>Click to resume file recovery. All other files will be renamed according to the specified rule.</td>
</tr>
<tr>
<td>Skip</td>
<td>Click to skip this file</td>
</tr>
<tr>
<td>Skip All</td>
<td>Click to skip all files and stop file recovery</td>
</tr>
</tbody>
</table>

**Note:** **R-Linux** recovers files from Ext2/3/4FS partitions, but can write them to any local or network disks. **R-Linux** recovers *symlinks* as files containing the path to files which *symlinks* point to.

**Opening several disk/partitions in one tab**

**Searching for a File**

**Finding Previous File Versions**

**Previewing Files**

**File Masks**

**Regular Expressions**

**Event Log**
2.1.1 Opening several partitions in one tab

You may open several partitions in one tab. Then you may search for files and recover them from several disks/partitions at once. This is especially useful if files are to be recovered from several recognized partitions found on one real partition or a drive.

To open several partitions in one tab,

1. Open one partition in a usual way (double-click a logical disk, for example).
2. Right-click the next partition, select Show Files In Tab, and select the tab you want the partition appear in, or
drag the disk/partition from the Device view to the required tab.

Now files may be searched for, marked for recovery, and recovered.

To remove a partition from the tab,

1. Right-click the required partition in the tab and select Close drive in the context menu.
Several partitions in one tab

2.1.2 Searching for a File

R-Linux can find a particular file, if it is difficult to find it manually on the Folders or Files panel. You can also automatically mark all found files.

To search for a file,

1. Click the Find button

   Other ways to search for the file
   - Right-click a folder and select Find on the context menu, or
   - Select a folder and select Find on the Tools menu

2. Specify a file to be found and its options on the Find dialog box, and click the OK button

   Note that a File Mask may be applied.

   **Find/Mark dialog box**

   **Find/Mark options**

   You may specify how to treat specified strings. Please note that R-Linux stores previously entered search strings.

<table>
<thead>
<tr>
<th>Files and folders</th>
<th>If this option is selected, R-Linux treats specified strings as file or folder names. Use ? for one unspecified character and * for an unlimited number of them to specify file masks.</th>
</tr>
</thead>
</table>

© 2023 R-Tools Technology Inc.
<table>
<thead>
<tr>
<th>File Extensions</th>
<th>If this option is selected, <strong>R-Linux</strong> treats specified strings as file extensions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Expressions</td>
<td>If this option is selected, <strong>R-Linux</strong> treats specified strings as regular expressions.</td>
</tr>
<tr>
<td>File Id</td>
<td>Specifies File Id that <strong>R-Studio</strong> assigns to a file.</td>
</tr>
<tr>
<td>All Files</td>
<td>If this option is selected, <strong>R-Linux</strong> applies Advanced Options to all files.</td>
</tr>
<tr>
<td>Match case</td>
<td>If this check box is selected, <strong>R-Linux</strong> makes a case-sensitive search.</td>
</tr>
<tr>
<td>Look at</td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>If this check box is selected, <strong>R-Linux</strong> includes files into a search.</td>
</tr>
<tr>
<td>Folders</td>
<td>If this check box is selected, <strong>R-Linux</strong> includes folders into a search. Disables when the Mark/Unmark All option is selected.</td>
</tr>
<tr>
<td>Deleted files</td>
<td>If this check box is selected, <strong>R-Linux</strong> makes a search among deleted files/folders.</td>
</tr>
<tr>
<td>Existing files</td>
<td>If this check box is selected, <strong>R-Linux</strong> makes a search among existing files/folders.</td>
</tr>
<tr>
<td>Look in</td>
<td>Specifies where <strong>R-Linux</strong> searches for, and marks, files. It can look for them on the Entire disk, or in/from a certain folder. You may specify the starting folder for the search.</td>
</tr>
<tr>
<td></td>
<td><strong>Recognized0</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Recognized0/Root</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Recognized0/Root/Files to Recover</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Identifies current opened folder.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Identifies current starting folder for the search.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Sets starting folder to the current opened folder.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Sets back current starting folder.</strong></td>
</tr>
<tr>
<td>Advanced options</td>
<td>If this check box is selected, <strong>R-Linux</strong> will use the advanced options.</td>
</tr>
<tr>
<td>Size from/up to</td>
<td>Specifies file size limits. See the <strong>Data Formats and Multipliers</strong> topic for more details on data formats.</td>
</tr>
<tr>
<td>Recovery Chances</td>
<td>Specifies files with certain recovery chances.</td>
</tr>
<tr>
<td>Date</td>
<td>Specifies file date boundaries. Dates for Modified, Created, and Last Accessed timestamps may be set separately.</td>
</tr>
<tr>
<td></td>
<td><strong>The Set for all</strong> button sets the specified data for all fields.</td>
</tr>
<tr>
<td>Find/Mark options</td>
<td>Specify what <strong>R-Linux</strong> does with the found files. The Find first/previous/next/last options. <strong>R-Linux</strong> stops at the first/previous/next/last file that matches the specified search criteria. Find all files. <strong>R-Linux</strong> searches for all files that matches the specified search criteria.. The search results appear on the <strong>Find Results</strong> panel.</td>
</tr>
</tbody>
</table>
Mark/Unmark All. **R-Linux** marks/unmarks all files that match the search criteria. When these options are selected, **R-Linux** marks/unmarks files only, not folders, regardless of what Look at: Folders specifies. Please note, that when performing a new find and mark/unmark task, **R-Linux** does not takes into consideration the previous marked/unmarked state of files. For example, if you first mark all doc files, and then all txt files, all doc files remain marked, too. To unmark them, you should specify doc once again and select Unmark files.

> **R-Linux** will show/mark the found file(s)

If you need to find and mark many files, go to the Find and Mark Multiple Files topic for details.

**To repeat the search,**

* Click the Find Next or Find Previous buttons

  ☐ **Other ways to repeat the search**
  
  - Right-click a folder and select **Find Next** or **Find Previous** on the context menu
  
  or
  
  - Select a folder and select **Find Next** or **Find Previous** on the Tools menu

**To find all files and show them on the Find Results panel,**

* Select Find all on the on the Find dialog box,

  or

  select Find all on the Tools menu

> **R-Linux** will show the found files on the Find Results panel

### 2.1.3 Finding Previous File Versions

**R-Linux** can find previous versions of files. It searches for them in the file's current folder and in Extra Found Files.

File versions are searched for using file size. If the size of a files is within 10% of the original filesize, the following conditions are checked:

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Legend</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>N</td>
</tr>
<tr>
<td>File extension</td>
<td>E</td>
</tr>
<tr>
<td>Recognized file type</td>
<td>T</td>
</tr>
</tbody>
</table>
To search for previous file versions,

1. Right-click the file and select Find Previous Versions of the File on the context menu

- R-Linux will show the files in the list:

```
File versions
```

This technique can be used to find deleted original files after attacks of file encrypting viruses.

### 2.1.4 Previewing Files

**R-Linux** has a built-in file previewer that allows you to preview both existing and deleted files. You may use this feature to estimate recovery or a file to be recovered.

**To preview a file**

1. Right-click a file to preview on the **Files** panel and select Preview on the context menu

   - **Other ways to preview the file**
     - Select the file on the **Files** panel and click the **Preview** button,
     - or
     - Select the file on the **Files** panel and select **Preview** on the **File** menu

- R-Linux will show the content of the file

If you have several files open in the previewer, you may instantly close all of them by selecting Close All Previews on the **File** menu.

**File Previewer for Pictures:**

Pictures can be previewed either as tiles within the main window of **R-Linux** or in an external previewer.

**Within the main window as tiles:**

Tile size can be changed..
Pictures as tiles

In the external viewer:
Picture files can be zoomed in/out.

Picture file previewer

File Previewer for Video and Audio files:
Video and audio files can be played even without their respective application installed.
File Previewer for Microsoft/Open/Libre Office Documents:
Documents can be shown (including embedded pictures) even without their respective applications installed. They can be zoomed in/out for better viewing.

File Previewer for Adobe Acrobat PDF Files:
Files can be shown even without Adobe Acrobat installed. The previewer allows the users to jump to a required page, zoom the document, and search for a required text.
The files can be shown in different layouts and rotated. Click the View menu and select the required options.

**Supported File Types:**

- **Documents:**
  - **MS Office** and **Open/Libre Office** files, even without the programs installed:
    - Word/Writer documents: docx;
    - Excel/Calc spreadsheets: xlsx;
    - PowerPoint presentation: pptx.
  - **Office 97-2003**, without the program installed:
    - Word documents: doc;
    - Excel spreadsheets xls;
    - PowerPoint presentation ppt.
  - **Adobe Acrobat** document: pdf.

- **Multimedia Files**
  - **Video formats:** AIFF, ASF, AVI, BFI, CAF, FLV, GIF, GXF, HLS, QuickTime, 3GP, MP4, Matroska, Maxis XA, MPEG-DASH, MPEG program stream, MPEG transport stream (including AVCHD), MXF, Material eXchange Format, SMPTE, MSN Webcam stream, NUT, Ogg, OMA, RL2, TXD, WTV.
  - **Audio formats:** 8SVX, AAC, AAC+, AC-3, ADPCM, AMR-NB, AMR-WB, Amazing Studio PAF Audio, Apple lossless audio, QuickTime, ATRAC, CELT, DCA (DTS Coherent Acoustics), DPCM, DSD (Direct Stream Digital), DSP Group TrueSpeech, DST (Direct Stream Transfer), DV audio, FLAC (Free Lossless Audio Codec), G.723.1, G.729, GSM, IAC (Indeo Audio Coder), iLBC (Internet Low Bitrate Codec), IMC (Intel Music Coder), Interplay ACM, MACE (Macintosh Audio Compression/Expansion), MACE (Macintosh Audio Compression/Expansion), MLP (Meridian...
Lossless Packing), Monkey’s Audio, MP1 (MPEG audio layer 1), MP2 (MPEG audio layer 2), MP3 (MPEG audio layer 3), MPEG-4 Audio Lossless Coding (ALS), Musepack SV7/SV8, Nellymoser Asao, AVC (Audio for Video Codec), PCM A-law/μ-law, QCELP / PureVoice, QDesign Music Codec, RealAudio, Vorbis, Voxware MetaSound, WavPack, Westwood Audio, Windows Media Audio, Xbox Media Audio

**Graphic files (with file extensions)**

- 3DS Max thumbnail (max), AAA logo (bpr), ACE texture (ace), ADEX (img, rle), AIM Grey Scale (ima, im), AIPD image (aipd), ARF (arf), AT&T Group 4 (att), AT&T multigen (icn), AVHRR Image (srt), AVT RAW (raw), AWD (awd), Ability Photopaint Image (apx), Access (g4, acc), Aces200 (ace), Acorn Sprite (acorn), AdTech perfectfax (adt), Adobe Illustrator (ai), Adobe PhotoParade(images) (php), Adobe Photoshop (psd), Advanced Art Studio (ocp, art, pic), AirNav (anv), Album bébé (frm), Alias Image File (pix, als, alias), Alpha Microsystems BMP (bmp), Amapi (2d), Amica Paint (ami, [b]), Amiga IFF (iff, blk), Amiga icon (imo), Amstrad Cpc Screen (cpc), Analyze (avw), Analyze-7 (img), Andrew Toolkit raster object (atk), Apollo HDRU (hdr, hdu, gn), ArcInfo Binary (hdr), Art Director (art), Artisan (art), Artist 64 (a64), Artrage (ptg), Artweaver Document (awd), Astronomical Research Network (arn), Atari grafik (pcp), Aurora (sim), Auto F/X (afx), AutoCAD DWG (dwg, dwt), AutoCAD DXF (dxf), Autocad CAD-Camera (img), Autodesk Animator (fli, flc), Autodesk QuickCAD thumbnail (cad), Autodesk SKETCH thumbnail (skf), Autodesk SketchUp component (skp, skb), Autologic (gm, gm2, gm4), Award Bios Logo (epa), Axialis Screensaver(images) (ssp), B3D(images) (b3d), BFLI (bfl, bfli, fl, flp, afl), BLAS FringeProcessor (msk, img, raw, flt), BLP textures (blp), BMF (bmf), BSB/KAP (kap), BYU SIR (sir), Bert’s Coloring (bmg, ibg), Bfx Bitware (bfx), Bio-Rad confocal (pic), Blazing Paddles (pip), Bob Raytracer (bob), Brende (pix), Brooktrout 301 (brk, 301, brt), Brother Fax (uni), Buttonz & Tilez texture (til), CALS Raster (cal, cals, gp4, mil), CDU Paint (cdu), CGM (cgm), Clip Image (dsi), CMU Window Manager (cnu), CP8 256 Gray Scale (cp8), CSV (csv), Calamus (cpi, crg), Camera RAW (raw), Canon EOS-1D Mark II RAW (cr2), Canon Navigator Fax (can), Canon PowerShot (crw), Cartes Michelin (big), Casio QV-10/100 Camera (cam), Casio RAW (bay, raw), Chinon ES-1000 digital camera (cm), Cisco IP Phone (cip), Cloe Ray-Tracer (clo, cloe), ColorIX (rix, sci, sex, sc?), CompW (wlm), CompServe GIF (gif, gift), Computer Eyes, Digital Vision (ce), ComputerEyes Raw (ce1, ce2), Contax RAW (bay, raw), Core IDC (idc), Corel Draw Bitmap (bmp), Corel Draw Pattern (bmp), Corel Draw Pattern (bmp), Corel Metafile Exchange (cmx), Corel PhotoPaint 6.0 (cpt), CoverDesigner(images) (ncd), CoverDesigner Template(images) (nt), Crayola (art), Creative PC-CAM RAW (bay, raw), DBW Render (), DIV Game Studio Map (map), DIV Game Studio Multi Map (fpg), DKB Ray-Tracer (dis), DNG (dng), DPX (dpx), Dali Raw (sd0, sd1, sd2), Datacopy (img), Degas & Degas Elite (p1, p1c, p2, pc2, p1b, pc3, p1d, p1e, p1f), Deluxe Paint, Electronic Arts (lbm, ibm), Dicom (dc2, acr, dic, dcm, dcm), Digital F/X (tdm), Digital Research(GEM Paint) (img, gem), Direct Draw Surface (dds), Discorp CMP Image (cmp), DjVu (djvu, djv, dw4), DolphinEd (dol), Doodle Atari (doo), Doodle C64 (dd), Doodle C64(Compressed) (jj), Dr Halo (cut), Draz Paint (dpr), EA Sports FSH (fish), EPS Interchange Format (epi, ept), ERI-chan(Entis Rasterized Image) (eri), ESM Software Pixmap (pix), Ecchi (ecce), Eclipse (tile), Edmics (c4), Egg Paint (trp), Electric Image (ei, eid), Embroidery (bmc), Encapsulated Postscript (ps, eps), Encapsulated Postscript (Preview) (eps), Enhance Simplex (esm), Enhanced Compressed Wavelet (ecw), Epson RAW (erf), Eroiica (eif), Everex Everfax (efx, ef3), Explore(TDI) & Maya (iff, tdi), FIF(Iterated...
System) (fif), FIT (fit), Face Painter (fpt), Fast Piecewise-constant (pwc), Fax Group 3 (g3, fax), Fax man (fmx), Faxable PCX (fcx), Faxable TIFF (ftf), Fenix Map (map), Fenix Multi Map (fgp), FileMagic (mag), Flash Image (fi), FlashCam Frame (ncy), FlashPix Format (fpx), Flexible Image Transport System (fits, fits, fit), Foculus RAW (bay, raw), Fontasy Grafik (bsg), Fremont Fax96 (f96), Fugawi Map (fx3), Fuji S2 RAW (raf), Fun Painter II (fp2, fun), Fun Photo (fpr), Fuzzy bitmap (fbm, cbm), GRS16 (g16), Gamma Fax (gmf), GeoPaint (geo), Gla Raytrace (sul), GigaPaint Hi-res (gh), GigaPaint Multi (gimp), Gimp Bitmap (xcf), Gimp Brush (gbr), Gimp Icon (ico), Gimp Pattern (pat), GoDot (4bit, 4bit, clp), GunPaint (gun, iff), HD Photo (wpd, hdp), HDR1 (hdr, hdr1), HF (hf), HP-48/49 GROB (gro, grb), HP-49 OpenFire (gro2, gro4), HPGL-2 (hp, hpg, hpl, hpgl, hpgl2, gl2, pm, pt, spl), HRU (hru), HSI Raw (raw), Half-Life Model (ml), Hasselblad RAW (3fr), Hayes JTFax (jtf), Hemera Photo Image (hpi), Hemera Thumbs (hta), Heretic II MipMap (m8), Hi-Eddi (hed), Hi, hbm), Homework Texture (lif), IBM Kips (kps), IBM Printer Page Segment (pse), IM5(Visilog) (im5), IMNET Image (imit), IOCA (ica, ioca, mod), IPLab (ipl), IPod thumb (ithmb), ISS (iss), ICOFX (ix), Icon Library (icl), Imacon/Hasselblad RAW (if), Image Capture Board (icb), Image Magic file (mif, miff), Image Speeder (ish), Image System(Hires) (ish), Image System(Multicolor) (ism), Image Systems RLC2 Graphic (rc), ImageLab (b&w, b_w), ImagePro Sequence (seq), Imaging Fax (g3n), Imaging Technology (img), Image Software Set (ims), Inshape (impan), InterPaint(Hires) (ip), InterPaint(Multicolor) (ipt), Intergraph Format (itg, cit, rel), Interleaf (eil), Iris CT (ct), Iris Graphics (iris), J Wavelet Image Codec (wic), JBIG (jbg, bie, jbig), JBIG-2 (jbi2), JFIF based file (jbf2), JPEG / JFIF (jpg, jpeg, jif, jif, J, jpe), JPEG 8BIM header(Mac) (jpg, jpeg, jif, jif, J, jpe), JPEG XR (jxr), JPEG-2000 Code Stream (jpc), JPEG-2000 JP2 File Format (jp2, j2k, jpx, jpf), JPEG-LS (jls), Jeff's Image Format (jif), Jig (jig), Jovian VI (vi), Jpeg Network Graphics (jng), JustButtons animated bitmap (btn), KONTRON (img), Khoros Visualization Image file (vif, vif, vx), KinuPix Skin (thb), Kiss Cel (cel), Koala Paint (kao, kla), Koala Paint(Compressed) (gg), Kodak Cineon (cin), Kodak DC120 Digital Camera (kdc), Kodak DC25 Camera (k25), Kodak Photo CD (pcd), Kodak Pro Digital RAW (dcr), Kofax Group 4 (kfx), Kolor Raw Format (kro), Konica Camera File (kcp), LSS16 (iss, 16), LView Pro (lvp), LaserData (lda), Leaf RAW (mos), Leica RAW (bay, raw), Light Work Image (lwi), LucasFilm Format (llf), Lumen CEL (cel), LuraDocument Format (lif), LuraDocument,Jim Format (jpm), LuraWave Format (lwf), LuraWave JPEG-2000 Code Stream (jpc), LuraWave JPEG-2000 Format (jp2, j2k, jpx, jpf), MAK1chan Graphics (mag), MGI Photosuite Project(images) (pzp), MGR bitmap (mgr), MRC(Medical Research Council) (mrc), MTV Ray-Tracer (mvb), Mac Paint (mac, mpnt, macp, pntg, pnt, paint), Mac icon (icns), Macintosh Quickdraw/Pict (pic, pict, pict2, pct), Mac OSX Resource (rsc, rsrc), Maggi Hairstyles & Cosmetics (ffh), Male MRI (pd, t1, t2), Male Normal CT (fre), Mamiya RAW (mrf), Marks Russel File (mrf), Mavica (411), Maw-Ware Textures (mtx), Mayura Draw (pdx), MegaPaint (bd), Megalux Frame (frm), Micro Dynamics MARS (pbt), Micro Illustrator Uncompressed (mil), Micrografx Picture Publisher 4.0 (pp4), Micrografx Picture Publisher 5.0 (pp5), Micron RAW (bay, raw), Microsoft Image Composer (mic), Microsoft Paint (msp), Microtek Eyestar (img), Mindjongg Format (jpg), Minolta DiMAGE RAW (mrw), Mobile FAX (rfm), MonkeyCard (pdb), MonkeyLogo (pdb), MonkeyPhoto (mph), MrSid (sid), Msx 2 Screen (sc2), Multiple Network Graphics (mng), NCR Image (ncr), NIST hdr (pct), National Imagery Transmission F. (ntf, nift), NeoBook Cartoon (car), Neochrome(ST & TT) (neo), Neopaint Mask (nmp), Neopaint Stamp (stw), NewsRoom (nsr, ph, bn), Nifti (img), Nikon RAW (nef), Nokia Group Graphics (ngg), Nokia Logo File (nlm), Nokia OTA bitmap (otb), Nokia Operator Logo (nol), OAZ Fax (oaz, xfx), OS/2 Bitmap (bmp, bga), Oliocom Fax (ofx), Olympus RAW (orf), Open Image Library Format (oil), OpenEXR (exr), Optigraphics (ctf), Optigraphics Tiled (ttf), Optocat (abs), Orcie Hires (hir), Orcie TAP (tap), Os/2
<table>
<thead>
<tr>
<th>Image Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warp (bga)</td>
<td>PABX background (pix)</td>
</tr>
<tr>
<td>PAX (pax)</td>
<td>PC Paint / Pictor Page (pic, clp)</td>
</tr>
<tr>
<td>PCO (b16)</td>
<td>PM (pm)</td>
</tr>
<tr>
<td>Page Control Language (pcl)</td>
<td>Paint Magic (pmt)</td>
</tr>
<tr>
<td>PaintShopPro Browser Cache File (jbf)</td>
<td>PaintShopPro Brush (pspbrush)</td>
</tr>
<tr>
<td>PaintShopPro Brush (jbr)</td>
<td>PaintShopPro Frame (pfr, pspframe)</td>
</tr>
<tr>
<td>PaintShopPro Image (ps, pspimage)</td>
<td>PaintShopPro Mask (pspmask)</td>
</tr>
<tr>
<td>PaintShopPro Mask (psm)</td>
<td>PaintShopPro Pattern (pat)</td>
</tr>
<tr>
<td>PaintShopPro Picture Tube (tub, pspimage)</td>
<td>PaintShopPro Texture (tex)</td>
</tr>
<tr>
<td>Palm Pilot (pdb)</td>
<td>Panasonic DMC-LC1 RAW (srf)</td>
</tr>
<tr>
<td>Panasonic LX3 RAW (rw2)</td>
<td>Panasonic RAW (bay, raw)</td>
</tr>
<tr>
<td>Pegs (pxs, pxa)</td>
<td>Pentax *ist D (pef)</td>
</tr>
<tr>
<td>Pf Art Publisher (art)</td>
<td>Photo Deluxe (pdb, pdb)</td>
</tr>
<tr>
<td>Photo Filtre Studio (pfi)</td>
<td>PhotoFantasy Image (fsy)</td>
</tr>
<tr>
<td>PhotoFrame (frm)</td>
<td>PhotoStudio File (psf)</td>
</tr>
<tr>
<td>PhotoStudio Stamp (stmn)</td>
<td>Photomatix (cat)</td>
</tr>
<tr>
<td>Pic2 (p2)</td>
<td>Picasso 64 (p64)</td>
</tr>
<tr>
<td>Picture Gear Pocket (prc)</td>
<td>Picture It! (mix)</td>
</tr>
<tr>
<td>Mix (mix)</td>
<td>Punk Productions Picture (ppl)</td>
</tr>
<tr>
<td>Punk (pun)</td>
<td>QuarkXPress (qxp)</td>
</tr>
<tr>
<td>QuarkXPress (qxp)</td>
<td>QuickTime Image Format (qtif, qti)</td>
</tr>
<tr>
<td>QuickTime Preview (qt)</td>
<td>RAW DMR (raw)</td>
</tr>
<tr>
<td>RIPTerm Image (icn)</td>
<td>Rainy Day Image (rdi)</td>
</tr>
<tr>
<td>Rainbow Painter (rp)</td>
<td>Raw (raw, gry, grey)</td>
</tr>
<tr>
<td>Raw (raw, gry, grey)</td>
<td>Real Storm File Format (rsb)</td>
</tr>
<tr>
<td>Real Storm File Format (rsb)</td>
<td>Ricoh Digital Camera (j6i)</td>
</tr>
<tr>
<td>Ricoh Fax (001, ric)</td>
<td>Ricoh ISOS (pig)</td>
</tr>
<tr>
<td>Ricoh ISOS (pig)</td>
<td>Rollei RAW (rdc, ia)</td>
</tr>
<tr>
<td>RoverShot RAW (bay, raw)</td>
<td>RunPaint(Multicolor) (rpm)</td>
</tr>
<tr>
<td>Saracen Paint (sar)</td>
<td>SBIG CCD camera ST-4 (st4)</td>
</tr>
<tr>
<td>StarOffice 8 (st)</td>
<td>Stereo Image (jps)</td>
</tr>
<tr>
<td>Stare It! (st)</td>
<td>Stereo Image (jps)</td>
</tr>
<tr>
<td>Seattle Film Works (sfw)</td>
<td>Seattle Film Works multi-image (pwp, sfw)</td>
</tr>
<tr>
<td>SecretPhotos puzzle (xp0)</td>
<td>Sega SJ-1 DIGIO (sj1)</td>
</tr>
<tr>
<td>Sharp GPB (img)</td>
<td>Siemens Mobile (bmx)</td>
</tr>
<tr>
<td>SIF MICHEL-Soft (sif)</td>
<td>Sigma RAW (x3f)</td>
</tr>
<tr>
<td>Silicon Graphics RGB (rgb, rgba, bw, irsi, sg, inta)</td>
<td>Sinar RAW (cs1, sti)</td>
</tr>
<tr>
<td>Skantek (skn)</td>
<td>Slow Scan Television (hrz)</td>
</tr>
<tr>
<td>SmartDraw 6 template (sdt)</td>
<td>SmartFax (1)</td>
</tr>
<tr>
<td>SmoothMove Pan Viewer (pan)</td>
<td>Softimage (pic, si)</td>
</tr>
<tr>
<td>Solitaire Image Recorder (sir)</td>
<td>Sony DSC-F1 Cyber-shot (mpm)</td>
</tr>
<tr>
<td>Sony DSC-F828 RAW (srf)</td>
<td>Sony PS2 TIM (tm2)</td>
</tr>
<tr>
<td>Sony PlayStation TIM (tim)</td>
<td>Sony RAW (sr2, arw)</td>
</tr>
<tr>
<td>Spectrum 512 (spu)</td>
<td>Spectrum 512(Compressed) (spc)</td>
</tr>
<tr>
<td>Spectrum 512(Smooshed) (spc)</td>
<td>SPOT (dat)</td>
</tr>
<tr>
<td>SticSun (ssi)</td>
<td>Stad (pic, pac, sq)</td>
</tr>
<tr>
<td>Star Office Gallery (sdg)</td>
<td>Starbase (img)</td>
</tr>
<tr>
<td>Stardent AVS X (x, avs, mbfs, mbfavs)</td>
<td>Starlight Xpress SX (RAW)</td>
</tr>
<tr>
<td>Stereoscopic Image (jps)</td>
<td>ST Micro RAW (bay, raw)</td>
</tr>
<tr>
<td>Structured Fax Format (stf)</td>
<td>Sun Icon/Cursor (icon, cursor, ico, pr)</td>
</tr>
<tr>
<td>Sun Rasterfile (ras, rast, sun, sr, scm, rs)</td>
<td>Sun TAAC file (iff, vff, sunIf, taac)</td>
</tr>
<tr>
<td>Syberia texture (sy)</td>
<td>Synthetic Universe (syn, synu)</td>
</tr>
<tr>
<td>SVG (svg)</td>
<td>TG4 (tg4)</td>
</tr>
<tr>
<td>TI Bitmap (92i, 73i, 82i, 83i, 85i, 86i, 89i)</td>
<td>TIFF Revision 6 (tif, tiff, tiffs)</td>
</tr>
<tr>
<td>TJ Satimage (jmi)</td>
<td>TRS 80 (hr)</td>
</tr>
<tr>
<td>TRS 80 (hr)</td>
<td>TidalPaint (pdp)</td>
</tr>
<tr>
<td>TediFax (mif)</td>
<td>Tiff Thumb (tm)</td>
</tr>
<tr>
<td>TilePic (tip)</td>
<td>Tiny (tiny, t1, n2, m3)</td>
</tr>
<tr>
<td>TopDesign Thumbnail (b3d, b2d)</td>
<td>Total Annihilation (gaf)</td>
</tr>
<tr>
<td>Truevision Targa (tga, targa, pix, bpx, ibv)</td>
<td>Ulead Pattern (psf)</td>
</tr>
<tr>
<td>Ulead Texture (images) (pe4)</td>
<td>Ulead Texture (images) (pe4)</td>
</tr>
<tr>
<td>Utah raster image (rl, ute)</td>
<td>VIPS Image (v)</td>
</tr>
<tr>
<td>Vit3c (vit)</td>
<td>VRML2 (wrl)</td>
</tr>
<tr>
<td>Venta Fax (vfx)</td>
<td>Verity (vff)</td>
</tr>
<tr>
<td>Vicar (vic, vicar, img)</td>
<td>Video Display Adapter (vda)</td>
</tr>
<tr>
<td>Vista (vst)</td>
<td>Vivid Ray-Tracer (img)</td>
</tr>
<tr>
<td>Vort (pix)</td>
<td>Vue d’esprit (vob)</td>
</tr>
<tr>
<td>WebShots (images) (wsh1, wbc, wbp, wbx)</td>
<td>Weekly Puzzle (jig)</td>
</tr>
<tr>
<td>WebP (webp, wep)</td>
<td>Whypic (ypp)</td>
</tr>
<tr>
<td>WinFAX (fxs, fxo, wfx, fxr, fxm)</td>
<td>WinMIPS (pic)</td>
</tr>
<tr>
<td>© 2023 R-Tools Technology Inc.</td>
<td></td>
</tr>
</tbody>
</table>
Windows & Aklus Metafile (wmf), Windows Animated Cursor (ani), Windows Bitmap (bmp, rle, vga, r4, r8, sys), Windows Clipboard (clp), Windows Comp. Enhanced Metafile (emz), Windows Compressed Metafile (wmz), Windows Cursor (cur), Windows DIB (dib), Windows Enhanced Metafile (emf), Windows Icon (ico), Winze Puzzle (wzl), Wireless Bitmap(level 0) (wbmp, wbm, wap), Word Perfect Graphics(images) (wpg), Worldport Fax (wfx), X Windows System dump (xwd, x11), X11 Bitmap (xbm, bm), X11 Pixmap (xpm, pm), XV Visual Schnauzer (p7), Xara(images) (xar), Xerox DIFF (xif), Ximage (xim), Xionics SMP (smp), YUV 16Bits (yuv, qt, uyvy), YUV 16Bits Interleaved (yuv, qt, uyvy), YUV 4:1:1 (yuv, qt), YUV 4:2:2 (yuv, qt), YUV 4:4:4 (yuv, qt), ZX Spectrum Hobetta ($s, $c, $s), ZX Spectrum Snapshot(sna), ZX Spectrum standard (screen scr), ZZ Rough (rgh), Zeiss BIVAS (dta), Zeiss LSM (lsm), Zoner Callisto Metafile(zmf), Zoner Zebra Metafile (zbr), Zsoft Multi-page Paintbrush (dcx), Zsoft Publisher's Paintbrush (pcx, pcc, dcx), byLight (bil)

2.1.5 File Masks

R-Linux shows only those files/folders that match the specified file mask. File mask affects files/folders that are processed by the Recover and Find commands.

To specify a file mask,

1 Click the File Mask button

- Other ways to specify the file mask
  - Right-click a folder and select File Mask on the context menu
  - Select the folder and select File Mask on the Tools menu

2 Specify the file mask on the File mask dialog box and click the OK button

Mask dialog box

<table>
<thead>
<tr>
<th>File mask options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match case</td>
<td>If this check box is selected, R-Linux makes a case-sensitive search.</td>
</tr>
<tr>
<td>Show empty folders</td>
<td>If this check box is selected, R-Linux will show folders with no files matching the mask.</td>
</tr>
<tr>
<td>Deleted files</td>
<td>If this check box is selected, R-Linux makes a search among deleted files/folders.</td>
</tr>
<tr>
<td>Existing files</td>
<td>If this check box is selected, R-Linux makes a search among existing files/folders.</td>
</tr>
<tr>
<td>Use advanced options</td>
<td>If this check box is selected, R-Linux will use the advanced options, even when they are hidden.</td>
</tr>
</tbody>
</table>
Advanced Options

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size from/up to</td>
<td>Specifies file size limits. See the Data Formats and Multipliers topic for more details on data formats.</td>
</tr>
<tr>
<td>Date</td>
<td>Specifies file date boundaries. Dates for Modified, Created, and Last Accessed timestamps may be set separately. The Set for all button sets the specified data for all fields.</td>
</tr>
<tr>
<td></td>
<td>The Set for all button sets the specified data for all fields.</td>
</tr>
</tbody>
</table>

> R-Linux will show only those files that match the specified file masks

Mask presets

You may set various presets with different file masks. Just click on the Plus button to add the data from the dialog box to the presets. You may also give presets names, delete them, and store them permanently.

2.1.6 Regular Expressions

Regular expression is a notation for patterns of text, as opposed to exact strings of characters. The notation uses literal characters and metacharacters. Every character which does not have special meaning in the regular-expression syntax is a literal character and matches an occurrence of that character. For example, letters and numbers are literal characters. A metacharacter is a symbol with special meaning (an operator or delimiter) in the regular-expression syntax.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Wildcard: any character</td>
</tr>
<tr>
<td>*</td>
<td>Repeat: zero or more occurrences of previous character or class</td>
</tr>
<tr>
<td>^</td>
<td>Line position: beginning of line</td>
</tr>
<tr>
<td>$</td>
<td>Line position: end of line</td>
</tr>
<tr>
<td>[class]</td>
<td>Character class: any character in the set</td>
</tr>
<tr>
<td>[^class]</td>
<td>Inverse class: any character not in the set</td>
</tr>
<tr>
<td>[x-y]</td>
<td>Range: any characters within the specified range</td>
</tr>
<tr>
<td>\x</td>
<td>Escape: literal use of metacharacter x</td>
</tr>
<tr>
<td>&lt;xyz</td>
<td>Word position: beginning of the word</td>
</tr>
<tr>
<td>xyz&gt;</td>
<td>Word position: end of the word</td>
</tr>
</tbody>
</table>

For example, the following regular expression .* matches any string of characters, ^a matches any string beginning with character a.

2.1.7 Event Log

R-Linux logs and displays events in the Log panel. You may set a Log filter to display only needed information and to write it to a log file. You may specify the log settings on the Settings dialog box.

You may clear or save the log

To clear the log,

* Right-click the Log panel and select Clear Log on the context menu.

To save the log to a file,

* Right-click the Log panel and select Save Log to File on the context menu.
2.2 Advanced Data Recovery

This chapter explains how to perform advanced data recovery operations.

- **Disk Scan**
- **Regions**
- **Exclusive Regions**
- **Images**

### 2.2.1 Disk Scan

In order to completely analyze data structure on an object, it must be scanned. Any object on the **Drives** panel can be scanned. In addition, you may create a **region** to scan only a part of an object. The **Regions** topic explains how to create and work with **regions**. Scan is also greatly improves estimations for chances of successful file recovery.

You may select scan area and some other scan parameters. Scan information may be saved to a file and later this file may be opened.

**Attention:** Scanning large areas may be a very lengthy process!

**NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!**

Or you may obtain unpredictable results and lose all your data.

#### To scan an object

1. **Select an object on the R-Linux's Drives panel**
2. **Click the Scan button**

   - **Other ways to start scan**
     - Right-click the selected disk and select **Scan** on the context menu,
     - or
     - Select **Scan** on the **Drive** menu
3. **Specify the required parameters on the Scan dialog box and click the Scan button**

**Scan dialog box**

- **Scan options**
  - **Disk Size:** Shows the size of the object to be scanned
  - **Start:** Sets the start point of the area to be scanned.
  - **Size:** Sets the size of the area to be scanned.
  - **File Systems:** Specifies the file systems which objects are to be searched for.

**Attention:** Scanning large areas may be a very lengthy process!

**NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!**

Or you may obtain unpredictable results and lose all your data.
Extra search for Known File Types

Save scan Info to File:

Simple view

Detailed view

Buttons

Scan

Advanced

Known File Types...

Cancel

Current version supports: Ext2/3/4FS.

Enables search for Known File Types.

If this checkbox is selected, **R-Linux** will save scan information to a specified file. Later this file may be opened. Please note, that this option does not save actual disk data, only information on disk data structure gathered during disk scan.

If this option is selected, **R-Linux** will show only scan progress.

If this option is selected, **R-Linux** will show graphic representation on objects found during scan.

**NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!**

Or you may obtain unpredictable results and lose all your data.

**Known File Types**: While scanning, **R-Linux** can recognize to which particular file type the data belong. Using such information, **R-Linux** can obtain more information about data/file structure on the object being scanned. By default, **R-Linux** tries to recognize all supported file types, greatly increasing time required for the scan. You may reduce it by selecting only those file types that you need. Click the **Known File Types**... button and select the required file types on the **File Types** dialog box.

**File Types dialog box**

![Known File Types dialog box]

- **Known File Types**
  - Click this button to set the current list of selected file types as default values.
  - Click this button to revert the default settings specified on the **Known File Types** tab of the **Settings** panel.
  - Click this button to revert to factory-preset default settings.
  - Click this button to select all file types in the list.
  - Click this button to clear all file types in the list except some predefined ones.

- **List of known file types**
  - * By default, files of this type are not selected. If necessary, select them manually

<table>
<thead>
<tr>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe PDF document</td>
</tr>
<tr>
<td>Microsoft Word2 document</td>
</tr>
<tr>
<td>Microsoft WordPad document</td>
</tr>
<tr>
<td>OLE Storage</td>
</tr>
<tr>
<td>Document</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td><strong>PostScript document</strong></td>
</tr>
<tr>
<td>Rich Text document</td>
</tr>
<tr>
<td>TEX document</td>
</tr>
<tr>
<td>Word for Macintosh document</td>
</tr>
<tr>
<td>WordPerfect document</td>
</tr>
<tr>
<td><strong>Document: Spreadsheet</strong></td>
</tr>
<tr>
<td>Lotus worksheet</td>
</tr>
<tr>
<td>Quattro Pro worksheet</td>
</tr>
<tr>
<td><strong>Document: Database</strong></td>
</tr>
<tr>
<td>Data Interchange Format file</td>
</tr>
<tr>
<td>Microsoft SQL Log</td>
</tr>
<tr>
<td><strong>Document: MS Office (OLE MS) (Word/Excel/PowerPoint)</strong></td>
</tr>
<tr>
<td>Microsoft Word document</td>
</tr>
<tr>
<td><strong>Internet-related files</strong></td>
</tr>
<tr>
<td>Compiled HTML file</td>
</tr>
<tr>
<td>Windows Address Book</td>
</tr>
<tr>
<td>The Bat! Message Base</td>
</tr>
<tr>
<td><strong>Font</strong></td>
</tr>
<tr>
<td>Adobe PostScript Font</td>
</tr>
<tr>
<td>CPI DOS font</td>
</tr>
<tr>
<td><strong>Graphics/Picture</strong></td>
</tr>
<tr>
<td>AVHRR Satellite image</td>
</tr>
<tr>
<td>AutoCAD Binary image</td>
</tr>
<tr>
<td>Autodesk Animator image</td>
</tr>
<tr>
<td>CompuServe GIF image</td>
</tr>
<tr>
<td>CorelDraw CMX image</td>
</tr>
<tr>
<td>Enhanced MetaFile image</td>
</tr>
<tr>
<td>GEM Raster image *</td>
</tr>
<tr>
<td>Multimedia: Audio Files</td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td>AIFF sound</td>
</tr>
<tr>
<td>CMF music</td>
</tr>
<tr>
<td>Extended M3U playlist</td>
</tr>
<tr>
<td>MPEG Layer I audio file *</td>
</tr>
<tr>
<td>Next/Sun sound</td>
</tr>
<tr>
<td>Sierra AUD sound</td>
</tr>
<tr>
<td>Windows WAVE sound</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Multimedia: Video Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANIM animation</td>
</tr>
<tr>
<td>DeluxePaint animation</td>
</tr>
<tr>
<td>LZA animation</td>
</tr>
<tr>
<td>QV-10 video</td>
</tr>
<tr>
<td>Smacker video</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Multimedia Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>RIFF Multimedia File</td>
</tr>
<tr>
<td>-----------------------------</td>
</tr>
</tbody>
</table>

**Archive Files**

<table>
<thead>
<tr>
<th>7-Zip archive</th>
<th>ACE archive</th>
<th>AIN archive</th>
<th>ARJ archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARX archive</td>
<td>Aladdin Systems StuffIt archive</td>
<td>BAG archive</td>
<td>BIX archive</td>
</tr>
<tr>
<td>BOA archive</td>
<td>BZip2 archive</td>
<td>BlackHole archive</td>
<td>Blink archive</td>
</tr>
<tr>
<td>CPIO archive</td>
<td>CRUSH archive</td>
<td>ChArc archive</td>
<td>Compress archive</td>
</tr>
<tr>
<td>FOXSQZ archive</td>
<td>GZip archive</td>
<td>HA archive *</td>
<td>HAP archive</td>
</tr>
<tr>
<td>HPACK archive</td>
<td>Hyper archive</td>
<td>InstallShield Cabinet archive</td>
<td>InstallShield Data archive</td>
</tr>
<tr>
<td>InstallShield archive</td>
<td>JAM archive</td>
<td>JAR archive</td>
<td>JRC archive</td>
</tr>
<tr>
<td>LHA/LZARK archive</td>
<td>LIMIT archive</td>
<td>LZA archive</td>
<td>LZOParchive</td>
</tr>
<tr>
<td>LZSH archive</td>
<td>LZX archive</td>
<td>Microsoft Cabinet archive</td>
<td>Microsoft Compress 5 archive</td>
</tr>
<tr>
<td>Microsoft Compress 6 archive</td>
<td>PAKLEO archive</td>
<td>Pack archive *</td>
<td>QFC archive</td>
</tr>
<tr>
<td>Quantum archive *</td>
<td>Quark archive</td>
<td>RAR archive</td>
<td>RPM archive</td>
</tr>
<tr>
<td>ReSOF archive</td>
<td>SAR archive</td>
<td>SBC archive</td>
<td>SCO archive *</td>
</tr>
<tr>
<td>SQZ archive</td>
<td>SZip archive</td>
<td>StuffIt archive</td>
<td>TAR archive</td>
</tr>
<tr>
<td>UFA archive</td>
<td>UHArc archive</td>
<td>UltraCompressor 2 archive</td>
<td>UltraCrypt 2 archive</td>
</tr>
<tr>
<td>WIN–Freeze archive *</td>
<td>WRAptor archive</td>
<td>WinImp archive</td>
<td>YAC archive</td>
</tr>
<tr>
<td>YBS archive</td>
<td>ZIP archive</td>
<td>ZOO archive</td>
<td>ZZip archive</td>
</tr>
</tbody>
</table>

**Executable/Library/DLL**

<table>
<thead>
<tr>
<th>DOS Style Executable</th>
<th>ELF Executable (UNIX)</th>
<th>ELF Library (UNIX)</th>
<th>ELF Module (UNIX)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Bytecode</td>
<td>Novell NetWare executable</td>
<td>RDOFF executable</td>
<td></td>
</tr>
</tbody>
</table>

**Development files**

<table>
<thead>
<tr>
<th>COM Type library Library</th>
<th>Microsoft ClassWizard file</th>
<th>Microsoft Linker database</th>
<th>Microsoft Precompiled header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Program database</td>
<td>Microsoft Visual C++ project</td>
<td>Microsoft Visual Studio project</td>
<td>Microsoft Visual Studio workspace</td>
</tr>
<tr>
<td>OMF Object library</td>
<td>Windows Compiled resource (16bit) *</td>
<td>Windows Compiled resource (32bit)</td>
<td></td>
</tr>
</tbody>
</table>

**Other file types**
Data Recovery Using R-Linux

<table>
<thead>
<tr>
<th>RegEdit file</th>
<th>RegEdit file (UNICODE)</th>
<th>WinHelp</th>
<th>WinHelp Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Clipboard file *</td>
<td>Windows Color Profile</td>
<td>Windows National locale</td>
<td>Windows Password file</td>
</tr>
<tr>
<td>Windows Policy file</td>
<td>Windows Registry file</td>
<td>Windows Registry hive</td>
<td>Windows shortcut</td>
</tr>
</tbody>
</table>

> **R-Linux** starts scanning the object, and its panel will show information about new found objects:

**R-Linux Main panel**

**Drives panel after scanning:**

You can select an object by clicking on it.
The Log pane will show scan progress. Scan may be stopped by clicking the Stop button on the toolbar. Later the scan process may be resumed with different scan parameters.

You may see which file object(s) is/are on a particular disk part. Click the corresponding rectangle on the Scan Information pane and view the information on the Scan Information dialog box.

Scan Information dialog box

Select the file object and click Open in Hex Viewer to view the file object in the Text/Hexadecimal Viewer.

To see the information about a newly found object, simply click it on the Drives panel. Click this link to see the information about the object Recognized0 on the partition.
When an object is scanned, a number of Recognized partitions will appear. **R-Linux** shows them in different colors depending on which elements of the partition have been found.

<table>
<thead>
<tr>
<th><strong>Partition</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Recognized]</td>
<td>An existing partition</td>
</tr>
<tr>
<td>![Recognized]</td>
<td>An existing partition after disk scan</td>
</tr>
<tr>
<td>![Recognized]</td>
<td>Both boot records and file entries are found for this partition</td>
</tr>
<tr>
<td>![Recognized]</td>
<td>Only file entries are found for this partition</td>
</tr>
<tr>
<td>![Recognized]</td>
<td>Only boot records are found for this partition</td>
</tr>
<tr>
<td>![DeletedPart]</td>
<td>A deleted partition</td>
</tr>
<tr>
<td>![Empty Space]</td>
<td>Empty space on the object</td>
</tr>
<tr>
<td><strong>Raw Files</strong></td>
<td>Files that have been found using scan for known file types</td>
</tr>
</tbody>
</table>

Although such recognized partitions are virtual objects, files can be searched for and recovered from recognized partitions as from real partitions using **Basic File Recovery**.

All scanned information may be deleted on the context menu for a scanned object.

Scan information may be saved in a file. Previously saved scan information may be loaded. This can be done on the **Drive** or context menu for a selected object.

**Multiple scans**

If the selected object has been completely scanned, you may rescan it either completely or with new scan parameters. If the selected object has been scanned partially, you may scan the rest of the object, ignore the existing scan information and scan the entire object, or specify scan parameters manually. **R-Linux** accumulates the information from successive scans and keeps track of changes in this information obtained from different scans.

You may make several scans of successive or overlapping areas. Click the **Advanced** button, specify an offset and size for a new area to scan on the **Advanced Scan** dialog box and click the **Add** button. You may specify and add several scan areas. You may select which areas should be scanned. Selected scan areas can be merged. Right-click a necessary area and select either **Merge Down**, **Merge Down All**, and **Merge Selected**.
Advanced Scan dialog box

Managing scan information
Scan information may be saved to a file. Previously saved scan information may be loaded.

To save scan information
1. Select an object on the R-Linux Drives panel
2. Select Save Scan Information on the Drive or context menu and save the scan information in a file
   The default file extension is *.dpl.

To load scan information
1. Select an object on the R-Linux Drives panel
2. Select Open Scan Information on the Drive or context menu and select the required file with the scan information
   The default file extension is *.scn.
   > The scan information will appear in the Drives panel

To delete scan information
1. Select an object on the R-Linux Drives panel
2. Select Delete Scan Information on the Drive or context menu
   > The scan information will disappear from the Drives panel
   NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!
   Or you may obtain unpredictable results and lose all your data.

2.2.2 Regions
Scanning large objects may take a long time. Sometimes, only a smaller area of a disk needs to be scanned or searched for files. Such area is called a *region*. A region can be created on any object in the R-Linux's Drives panel.
Created regions can be scanned, and files on them can be recovered in the same way as from hard drives or partitions.
Created regions can be deleted.
Note: R-Linux does not create anything real on the disk. Regions are virtual objects that do not affect actual data on the disk.
To create a region

1. Select an object on the R-Linux's Drives panel and click the Create Region button
   - Other ways to create the region
     * Right-click the selected object and select Create Region on the context menu
     * Select the object and select Create Region on the Create menu

2. Specify required parameters on the Create region dialog box and click the Create button

   Create region dialog box

   **Region options**
   - Disk size: Shows size of the object where the region is to be created. The region cannot be larger than this size.
   - Start: Start point of the region
   - Size: Size of the region. Cannot be larger than Disk size.

   Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for more details on data formats.

   > A Region object will appear on the Drives panel.

   To change the size of a region
   * Right-click the Region on the R-Studio Drives panel, select Edit on the shortcut menu, and enter a new size on the Edit Region dialog box.

   To convert a region into an exclusive one
   * Right-click the Region on the R-Studio Drives panel and select Exclude area on the shortcut menu

   To delete a region
   * Select a Region on the R-Linux Drives panel and click the Delete button, or
     * Right-click the selected region and select Delete Region on the context menu.

2.2.3 Exclusive Regions

Exclusive regions are areas on any object visible on the R-Linux's Drives panel that are excluded from disk operations. R-Linux never tries to read/write data from/to such area. Exclusive regions are necessary when, for example, there are areas with bad sectors on a hard drive, and it is necessary to avoid any disk operations with such areas to not inflict further damage to such drive and to speed work with it.
Note: R-Linux does not create anything real on the disk. Exclusive regions are virtual objects that do not affect actual data on the disk.

To create an exclusive region

1. Right-click an object on the R-Linux’s Drives panel and select Create Exclusive Region on the shortcut menu, or
   Select the object and select Create Exclusive Region on the Create menu

2. Specify required parameters on the Create Exclusive Region dialog box and click the Add button

Create exclusive region dialog box

<table>
<thead>
<tr>
<th>Exclusive Region options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset:</td>
</tr>
<tr>
<td>Size:</td>
</tr>
</tbody>
</table>

Numbers in these fields can be in bytes or sectors. See Data Formats and Multipliers for more details.

> An Exclusive Region object will appear on the Drives panel.

Its properties can be seen on the Excluded Areas tab.

To delete an exclusive region

* Select an Exclusive Region on the R-Linux Drives panel and click the Delete button, or
  Right-click the selected region and select Remove Region on the context menu.

To change the size of an exclusive region

* Right-click an Exclusive Region on the R-Linux Drives panel, select Edit on the context menu, and add/delete excluded areas on the Edit Exclusive Region tab.
  You may delete an excluded area by right-clicking it and selecting Remove on the context menu.
2.2.4 Images

An *image* is an exact, byte by byte, copy of any object on the *Drives* panel. When created, images can be processed like their original objects. Images are very useful if there is a risk of total data loss due to hardware malfunction. If bad blocks are constantly appearing on a hard drive, you must immediately create an image of this drive. While creating images, *R-Linux* can simultaneously perform disk scan and save scan information to lessen time necessary to process the disk. All data search, scan and restoring can be done from this image.

**To create an image,**

1. Select an object on the *R-Linux*’s *Drives* panel and click the Create Image button
   - **Other ways to create the image**
     - Select the object and select *Create Image* on the *Drive* menu
     - Right-click the selected object and select *Create Image File* on the context menu

2. Specify image options, a file name, and destination for the *image* on the *Create Image* dialog box

   **Note:** To store an image file, you need a free space equal to at least the object size.

   **Create Image dialog box**

   ![Create Image dialog box]

   **Create Image (Scan Information) dialog box**

   ![Create Image (Scan Information) dialog box]
## Create Image dialog box

### Image Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image name</strong></td>
<td>Specifies the name and path for the image file</td>
</tr>
<tr>
<td><strong>Plain image</strong></td>
<td>If this option is selected, <strong>R-Linux</strong> will create a simple exact copy of the object. This image format is compatible with the previous versions of <strong>R-Linux</strong>.</td>
</tr>
<tr>
<td><strong>Compressed image (R-Drive Image compatible)</strong></td>
<td>If this option is selected, <strong>R-Linux</strong> will create an image file which can be compressed, split into several parts, and password-protected. This image file is fully compatible with the images created by <strong>R-Drive Image</strong>, but incompatible with the previous versions of <strong>R-Linux</strong>.</td>
</tr>
<tr>
<td><strong>Image compression ratio</strong></td>
<td>You may compress the data in the image to save space. Active only if the Compressed image (R-Drive Image compatible) is selected.</td>
</tr>
<tr>
<td><strong>Estimated size</strong></td>
<td>Shows the estimated size of the image file. An actual image size depends on how much empty space is on the selected partition and what file types are there. Active only if the Compressed image (R-Drive Image compatible) is selected.</td>
</tr>
<tr>
<td><strong>Image split size</strong></td>
<td>You may set this option to Automatic and let the system decide how to split the image file. This mostly depends on the file system on the destination disk. You may also either explicitly specify the split size, or choose a preset for various devices with removable storage. Select Fixed size for that. Active only if the Compressed image (R-Drive Image compatible) is selected.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>You may protect your image file with a password. <strong>Note:</strong> This feature provides a relatively moderate protection against conventional unauthorized access. Active only if the Compressed image (R-Drive Image compatible) is selected.</td>
</tr>
<tr>
<td><strong>Create scan information file</strong></td>
<td>If this option is selected, <strong>R-Linux</strong> will perform disk scan simultaneously with image creation. See the <strong>Disk Scan</strong> help page to learn scan options.</td>
</tr>
<tr>
<td><strong>Read retries</strong></td>
<td>Specifies a value for I/O Tries, or how many times <strong>R-Linux</strong> will try to read a bad sector. <strong>R-Linux</strong> treats bad sectors in the following way: It reads a certain part of disk (predefined by Windows) and • If Default read attempts is set to 0, the entire part with bad sectors will be filled with the specified pattern.</td>
</tr>
</tbody>
</table>

© 2023 R-Tools Technology Inc.
If Default read attempts is set to a non-zero value, **R-Linux** reads again that part sector by sector, repeating the attempts the specified number of times. If **R-Linux** still cannot read a bad sector, it fills the sectors with the specified pattern. In this case only the bad sectors will be filled with the pattern, but that extremely slows the disk read process. For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

| Pattern to fill bad blocks | Specifies a pattern **R-Linux** will use to fill bad sectors in this image. You may specify the pattern either in the ANSI or Hex data format. Note: **R-Linux** will never ever try to write anything on the disk from which data is to recover or an image is to create. This pattern fills bad sectors only in the image. |

**R-Linux will start creating the image, the Progress message showing the progress.**

You may change some options during the imaging process. Click the **Options** button and change them as necessary.

You may stop the imaging process and then resume it later on. Click the **Stop** button and the **Cancel drive operation** dialog box will appear. Select **Stop** if you want to keep the partially created image or **Discard** if you don't need this image file.

To resume the creation of the image for the same object, select the same file name for the image. You'll be able to create a new image file or continue to create the image for the object.

**Resuming image creation**

**R-Studio for Linux** will create a new file for every new start of imaging for the .rdi file type.
To process an already created Image, the image file should be opened.

To open an image

1. Click the Open Image button, or
   Select Open Image File on the Drive menu
2. Select the required image file

> An Image object will appear on the Drives panel

Depending whether this is a byte-by-byte, compressed (R-Drive Image compatible), or multi-volume, image, its appearance in the Drives panels is different.

You may perform all data search, scan, and recovery from this image as if it were a regular drive/disk object.

<table>
<thead>
<tr>
<th>Device/Disk</th>
<th>/</th>
<th>Label</th>
<th>FS</th>
<th>Start</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>KINGSTON SA400537120G 03090005</td>
<td>50026B77843A5628</td>
<td>SATA2</td>
<td>0 Bytes</td>
<td>111.79 GB</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
<td>Ext4</td>
<td>1 MB</td>
<td>103.41 GB</td>
<td></td>
</tr>
<tr>
<td>Partition1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAMSUNG HD42JJ 1AA01110</td>
<td>51AFJLMQ400283</td>
<td>SATA2</td>
<td>0 Bytes</td>
<td>596.17 GB</td>
<td></td>
</tr>
<tr>
<td>/home</td>
<td></td>
<td>Ext4</td>
<td>1 MB</td>
<td>596.17 GB</td>
<td></td>
</tr>
<tr>
<td>image</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>08/24/2022 10:53:31 - Incomplete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A multi-volume image
To close an image
* Select the image and click the Close Image button,
  - or right-click the image and select Close Image on the shortcut menu
  - or select the image and press the F8 key.

To close all image
* Select Close All Images on the Tools menu

A logical disk (or disks) containing in an image can be mounted in the operating system as a device which makes its content accessible to any program including any other data recovery software.

2.3 Mass File Recovery

Recovery of multiple files
If you need to recover multiple files you may do it through the following steps:

1 Find and mark all the necessary files
   Go to the Find and Mark Multiple Files topic for more information

2 Recover all marked files in a single file recovery step
   Go to the Recover Multiple Files for more information

Memory considerations
R-Linux stores information about found files in computer memory. If there are too many files, R-Linux may run out of it. To avoid this, you have two options:

Recover all files
If you want to recover data from an entire file system object (a partition, partition image, etc.), you may use the Recover All Files command from the Drive or context menu. Right click the object in the Drives panel to access the context menu. A Recover dialog box will appear. Select required restore settings, including file mask. This command restores unlimited number of files without memory restrictions.

View file information in steps
As soon as R-Linux nearly runs out of memory, a Too many files... message appears. You may temporarily stop file listing and browse through found files. Then you can resume file listing. You also may skip this file section and continue file listing.
In all cases, R-Linux keeps information about the entire file structure.
• Find and Mark Multiple Files
• Recover Multiple Files
2.3.1 Find and Mark Multiple Files

If you need to find and mark many files at once, you may do that in the following ways:

* **By sorting them by their extensions or creation/modification/accessed time**

To sort files by their extensions or creation/modification/accessed time,

- On the **Folders/Files** panel select the tab
  - **Extensions** to sort the files by their extensions
  - **Creation Time** to sort the files by their creation time
  - **Modification Time** to sort the files by their modification time
  - **Accessed Time** to sort the files by their accessed time

**Other ways to sort files by their extensions or creation/modification/accessed time**

- Select the disk on **Drives** panel, select **Open Drive Files Sorted By** on the **Drive** menu, and select respective option,
  
- On the **Folders** panel, right-click the disk letter and select **Show Files Sorted By** on the context menu and select respective option,
  
- On the **Folders** panel, select **Show Files Sorted By** on the **Drive** menu and select respective option.

> **R-Linux will show the sorted files in the Folders and Content panels, showing the path to each file:**

- **Folders** panel for files sorted by their extensions

- **Content** panel with files/folders sorted by their extensions
To return to the conventional view,
* On the Drives panel, right-click the partition, select Open Drive Files Sorted By on the context menu, and select Real File System Structure,

or

On the Folders panel, select Show Files Sorted By on the Drive menu and select Real File System Structure

By finding and marking multiple files using the Find/Mark dialog box
You may find and mark all the files on the entire disk by using Mark matched files in the Find/Mark mode option. You may specify all the necessary search options and mark all the found files. Please note that each find and mark/unmark operation is independent from previous ones. That is, if a file matches the search criteria, it will be marked/unmarked regardless of its previous marked/unmarked state.
For example, if you first mark all doc files, and then all txt files, all doc files remain marked, too. If you then decide to unmark all files smaller than 2 kB, all doc and txt files will stay marked except those that less than 2 kB.

2.3.2 Recover Multiple Files
If R-Linux while recovering files encounters either an already existing file or file with a broken name, normally it will stop working and ask you what to do with the file. If you recover multiple files, that may require you answer a lot of the same questions. You may use Mass File Recovery Options on the Recover dialog box to instruct R-Linux what to do in those cases for all files.

Recover dialog box

<table>
<thead>
<tr>
<th>Mass File Recovery Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Already Exists</strong></td>
<td>These options instruct R-Linux what to do if there already exists a file with the same name.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>If this option is selected, R-Linux asks the user what to do for each such file. It stops file recovery until it receives the answer.</td>
</tr>
<tr>
<td><strong>Add a File ID to filename</strong></td>
<td>If this option is selected, R-Linux adds a File ID to the file name. If a file already exists with the same name and that file ID, a number will be added to th file name and file ID.</td>
</tr>
<tr>
<td><strong>Overwrite</strong></td>
<td>If this option is selected, R-Linux overwrites the old file with the new one.</td>
</tr>
<tr>
<td><strong>Skip</strong></td>
<td>If this option is selected, R-Linux skips all new files with the same name.</td>
</tr>
<tr>
<td><strong>Broken File Name</strong></td>
<td>These options instruct R-Linux what to do if a file to be recovered appears to have an invalid name.</td>
</tr>
</tbody>
</table>
**Prompt**
If this option is selected, **R-Linux** shows the standard *Broken File Name* dialog box for each file with a broken file name. It stops file recovery until it receives the answer.

**Rename and change all invalid symbols to:**
If this option is selected, **R-Linux** changes all invalid characters to the character specified.

**Skip**
If this option is selected, **R-Linux** skips all files with broken file names.

**Extended options**
These options give you more flexible ways to process multiple files with the same name. You may compare files by time (Modified) and size, and decide what **R-Linux** should do with those duplicates. If any of the files has an invalid time, the comparison by time is skipped. In this case, if comparison by size is not active, **R-Linux** goes to the default action.

**Recover (Advanced - Extended options) dialog box**

![Recover dialog box]

**Extended advanced file recovery options**

<table>
<thead>
<tr>
<th>First compare time</th>
<th>These options instruct <strong>R-Linux</strong> which condition to use first, file time or size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First compare size</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Compare time</th>
<th>These options instruct <strong>R-Linux</strong> to enable comparison by time and size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare size</td>
<td></td>
</tr>
</tbody>
</table>

**Actions**
These selectable actions instruct **R-Linux** what to do if the condition is met.

<table>
<thead>
<tr>
<th>Empty field</th>
<th>If this option is selected, <strong>R-Linux</strong> skips the condition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>If this option is selected, <strong>R-Linux</strong> asks the user what to do for each such file. It stops file recovery until it receives the answer.</td>
</tr>
<tr>
<td>Rename</td>
<td>If this option is selected, <strong>R-Linux</strong> adds a File ID to the file name. If a file already exists with the same name and that file ID, a number will be added to the file name and file ID.</td>
</tr>
<tr>
<td>Skip</td>
<td>If this option is selected, <strong>R-Linux</strong> skips all new files with the same name.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>If this option is selected, <strong>R-Linux</strong> overwrites the existing file with the new one.</td>
</tr>
</tbody>
</table>

**Time conditions**
If the Modified time stamp is invalid, **R-Linux** will skip the comparison.
<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal time</td>
<td>Two time stamps are the same.</td>
</tr>
<tr>
<td>Older</td>
<td>The existing file is older than the new one.</td>
</tr>
<tr>
<td>Newer</td>
<td>The existing file is newer than the new one.</td>
</tr>
<tr>
<td>Size</td>
<td></td>
</tr>
<tr>
<td>Equal size</td>
<td>Two files have the same size.</td>
</tr>
<tr>
<td>Smaller</td>
<td>The existing file is smaller than the new one.</td>
</tr>
<tr>
<td>Bigger</td>
<td>The existing file is bigger than the new one.</td>
</tr>
<tr>
<td>By default</td>
<td>The action R-Linux takes when none of the comparison conditions have been met. That may happen when the comparison by size is not enabled.</td>
</tr>
</tbody>
</table>

### 2.4 Various Disk and Volume Managers

R-Linux can work with objects created by various Linux disk and volume managers. Currently, the following managers are supported:

- **Linux mdadm RAIDs**
- **Logical Volume Manager (LVM and LVM2)**

R-Linux can automatically recognize and add their physical components, component images, or the user can manually add the components when their data is damaged so severely that R-Linux cannot recognize them.

#### 2.4.1 Linux mdadm RAIDs

mdadm is a Linux utility used to manage and monitor software RAID devices.

R-Linux supports such devices and when drives from a mdadm RAID are connected to a Linux computer, it automatically detects them and assembles mdadm RAIDs accordingly.

**Linux mdadm RAIDs**

R-Linux detects components from mdadm RAIDs and creates those RAIDs automatically. At the same time, R-Linux gives access to the components of those RAIDs (hard drives and images).
When an automatically created `mdadm` RAID is selected, **R-Linux** highlights its components. It also highlights the `mdadm` RAID that Linux may itself create from the same components.

**R-Linux** shows broken `mdadm` RAIDs in pink.

### 2.4.2 Linux LVM/LVM2

Linux LVM is a logical volume manager for the Linux OS that manages disk drives and other data storage devices. Using it, it is possible to create single logical volumes on several physical disks, add and replace them in a running system, resize logical volumes, create various RAID configuration, and so on. You may read more about Linux LVM on this Wikipedia article: [Logical Volume Manager (Linux)](https://en.wikipedia.org/wiki/Logical_Volume_Manager_(Linux)).

**LVM volume example**

**R-Linux** automatically detects disks from LVMs and creates their virtual volumes automatically. At the same time, **R-Linux** gives access to the components of the virtual LVM volumes (hard drives and images).
LVM Volumes in R-Linux

When an automatically created LVM volume is selected, R-Linux highlights its components. It also highlights the LVM volume that Linux may itself create from the same components. R-Linux shows broken virtual LVM volumes in pink. Broken LVM volumes in R-Linux
III Text/Hexadecimal Viewer

Any object visible by R-Linux can be viewed in the Text/Hexadecimal Viewer. It is also able to parse the data and represent data according to various data patterns.

- Viewing Objects
- Navigating through an Object
- Data Copy
- Files and Sectors
3.1 Viewing Objects

To view an object,

1. Right-click the object and select View on the context menu

   - Other ways to view the object
     - Select the object and select View on the File menu
     - Select the object and press the Ctrl+E keys

   A Viewer panel will appear

   R-Linux Text/Hexadecimal viewer
### Data Parsed According to the Selected Pattern

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Object Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td></td>
</tr>
</tbody>
</table>

### Object Sector Mapping

<table>
<thead>
<tr>
<th>Sector</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
</tbody>
</table>

### Data Shown as Various Digits

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2023 R-Tools Technology Inc.
<table>
<thead>
<tr>
<th>Offset</th>
<th>Binary data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Text view**

Find Results

List of Bookmarks

<table>
<thead>
<tr>
<th>Bookmark</th>
<th>Location</th>
<th>Offset</th>
<th>Sector</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Text/Hexadecimal Viewer** status

© 2023 R-Tools Technology Inc.
2 View the information

Viewing
You may view data in 4 various code pages: ANSI/OEM/UNICODE/UNICODE+ by switching on/off the respective code pages in the Code pages buttons or select the appropriate code pages on the View menu.

Patterns or Templates
You may select a pattern according to which the data will be parsed and shown in the parsed data pane. The Data Interpreter shows the data selected on the Template pane in various representations. You may find the next or previous data that matches the pattern signature on the disk. Right-click the right pane of the viewer and select either Find Template Signature Next or Find Template Signature Previous on the context menu. You may also select these items on the Edit menu.
Navigating.
Text/hexadecimal viewer gives you various ways to navigate into an object. See the Navigating through an Object for more details.

Data Copy
Text/hexadecimal viewer gives you various ways to copy selected data navigate in an object. See the Data Copy for more details.

Selecting and saving an area in the Viewer
You may select an area in the Viewer panel and save it as a file.

To select and save an area in the Viewer panel,
1 Right-click the beginning of the selection and select Select From on the context menu
2 Right-click the end of the selection and select Select To on the context menu
   Other ways to select an area
   • Select Select... on the Tools menu and specify an area to select on the Select dialog box, or
   • Click the start point of the area and drag the mouse cursor to its end.
   If you need to select an entire object, select Select All on the Tools menu or click the Ctrl+A key

Select dialog box

3 Select an appropriate item in the Tools menu to save the data in a required format and specify its file name
Select:

<table>
<thead>
<tr>
<th>Save to Binary File...</th>
<th>to save the data in the binary format (default extension is .bin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to Hexadecimal File</td>
<td>to save the data in the binary format (default extension is .hex)</td>
</tr>
</tbody>
</table>

Select dialog box

If you select an existing file, R-Linux will ask you if you want to append or overwrite the file.

Viewer will save the data to the file

3.2 Navigating through an Object

Navigating
You may quickly move to a particular part of the object. To move to a particular part of the object being viewed/edited, enter the required offset in the Go to Offset field between the buttons.

Type an offset to which you want to go. You may select between bytes and sectors. See the Data Formats and Multipliers topic for more details on data formats.
You may also use the **Go To Offset** dialog box to go to a specified place in the object. Click the Offset field on the Status bar. You may also use this dialog box to copy the offset.

### Go To Offset dialog box

<table>
<thead>
<tr>
<th>Go To Offset options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From:</td>
<td>Jump / offset direction. For example, if you need to find the offset from the object end for a selected byte, switch to the End (backward) option.</td>
</tr>
<tr>
<td>HEX / DEC</td>
<td>Switch between the hexadecimal and decimal data representation.</td>
</tr>
<tr>
<td>Range</td>
<td>Range of values that can be entered.</td>
</tr>
<tr>
<td>dec / hex:</td>
<td>Alternative data representation.</td>
</tr>
<tr>
<td>Offset:</td>
<td>Flat data offset (without separation between the sector and offset in the sector).</td>
</tr>
<tr>
<td>Sector / offset</td>
<td>Data offset represented as a sector and offset in the sector.</td>
</tr>
<tr>
<td>Go! / OK buttons</td>
<td>The Go! button moves the cursor to the specified positions, but the Go To Offset dialog box remains open. The OK button closes the dialog box after moving the cursor.</td>
</tr>
</tbody>
</table>

### Searching

To search for a particular string, click the **Find**, **Find Next**, or **Find Previous** buttons or the same items on the Edit menu, and specify the string on the **Search** dialog box.

### Search dialog box

<table>
<thead>
<tr>
<th>Search options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Equal</td>
<td>Search for the place which content is not equal to the string. For example, the first byte not equal to 00 or FF.</td>
</tr>
</tbody>
</table>

---

© 2023 R-Tools Technology Inc.
HEX | Field for the string to search for in the hexadecimal representation
---|---
ANSI | Field for the string to search for in the ANSI encoding
OEM | Field for the string to search for in the OEM encoding
UNICODE | Field for the string to search for in the UNICODE encoding
Match case | Select this check box to make the search case-sensitive

**Search area**
- From current position: Select this check box to start search from the current position
- From start position: Select this check box to start search from the beginning of the object
- From Address: Select this check box and specify the range in which the search is to be carried out

**Search position**
- Exhaustive search: Select this check box to search the entire object
- Search at offset: Select this check box and specify the sector offset from which the search will start
- Reverse: Select this check box to start the search in the reverse direction
- Find all: Select this check box to search for all instances of the string to search. Search results will be shown in the **Find Results** pane.

*Text/Hexadecimal Viewer* will show the search progress.

Search results are shown on the **Find Results** pane. You may easily move to the required found item by clicking the item.

**Features of the Not Equal option**
Suppose we have an object which first 3 consecutive sectors start with:

- Sector1: FILEAAAAA..........................
- Sector2: FILEBBBBB..........................
- Sector3: NOTAFILE..........................

And the search string is **Not Equal** FILE.
If the Exhaustive search option is selected, the *Text/Hexadecimal Viewer* will stop at the first A character in Sector1.
If the Search at offset=0 option is selected, the *Text/Hexadecimal Viewer* will stop at the N character in Sector3.

**Bookmarks**
You may create bookmarks to easily move to those places. Right-click the cursor on the place you want to bookmark and select **Toggle Bookmark** on the shortcut menu. The list of bookmarks appears in the **Bookmark** pane. You may easily move to the required bookmark by clicking it in the list.
You may control bookmarks on the **Edit** menu.
3.3 Data Copy

Text/hexadecimal Viewer gives you various ways to copy selected data in an object.

**Data selected in Text/hexadecimal viewer**

Depending on what column you have control-clicked, the following commands are available in the context menu:

- **When right-clicking any column**
  - Copy Editor Display

- **Data pasted into a text editor**

- **When right-clicking any column**
  - Copy as File Signature

- **Data pasted into a text editor**

- **When right-clicking the Binary data column**
  - Copy as "Binary data"

- **Data pasted into a text editor**

- **When right-clicking the ANSI column**
  - Copy as "ANSI"
3.4 Files and Sectors

You may see which file is written on a particular sector. To do so:

1. **Enumerate files on a logical disk on the Drives panel.**
2. **Go to the tab of that logical disk and select Show Files in HexViewer on the Files menu.**
3. **Return to the Drives panel and select View on the shortcut menu.**

> **R-Linux** will show a file that belongs to a particular section.

**File in a sector**

<table>
<thead>
<tr>
<th>Sector</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345678</td>
<td>12345678</td>
</tr>
<tr>
<td>87654321</td>
<td>23456789</td>
</tr>
<tr>
<td>98765432</td>
<td>34567890</td>
</tr>
<tr>
<td>09876543</td>
<td>45678901</td>
</tr>
<tr>
<td>10987654</td>
<td>56789012</td>
</tr>
<tr>
<td>21098765</td>
<td>67890123</td>
</tr>
<tr>
<td>32109876</td>
<td>78901234</td>
</tr>
<tr>
<td>43210987</td>
<td>89012345</td>
</tr>
<tr>
<td>54321098</td>
<td>90123456</td>
</tr>
</tbody>
</table>

**Title:** File belongs to file sector

---

© 2023 R-Tools Technology Inc.
IV Technical Information and Troubleshooting

This chapter covers various technical issues and troubleshooting.

- IntelligentScan technology
- Data Recovery Issues
- Data Formats and Multipliers
- Bad Sectors
- Memory Usage
- R-Linux Switches
- Properties Tab

R-Studio Features

Contact Information and Technical Support

Data Recovery Using R-Linux

Basic File Recovery

Advanced Data Recovery

Mass File Recovery

Text/Hexadecimal Viewer

4.1 IntelligentScan Technology

R-Studio uses a unique IntelligentScan technology when it tries to recover the data on the area being scanned.

While scanning the selected area, R-Studio reads data directly from the disk, analyzes them, and tries to determine a record to which the data belong. The following record types are possible:

- MBR/GPT records
- NTFS Boot Sector, Folder, and MFT records
- FAT/exFAT Boot Sector, folder, and file records
- ReFS Boot sector records and ReFS Meta blocks
- HFS/HFS+ Volume headers and BTree+ nodes
- APFS Super blocks, APFS Volume blocks, and APFS nodes
- Ext2/3/4FS SuperBlocks records
- UFS/FFS SuperBlock records
- Specific file signatures of Known File types for raw file carving

All these record types have different, but known, structure. Knowing valid values of record fields and relations between them for each record type, R-Studio determines a record type for the data. If such record type cannot be unambiguously determined, the data are assigned to the most probable record type. The same data can be assigned to several record types, with a certain probability for each assignment. A list of possible files is generated from these records.

R-Studio generates a record list for each record type. This list contains references to records assigned to a record type from the list with their assignment probability. The same data can be included into different record lists. Then R-Studio analyzes relations between elements in each list and between different lists, and generates
a list of found partitions with their parameters, such as partition start point and probable size, file system type, cluster size, and existence probability.

Using the file list and partition list, R-Studio reconstructs file systems and files on the found partitions. One file can be attributed to several different partitions.

When the entire disk or its part has been scanned, R-Studio shows all found partitions. Then the parameters of the found partitions may be manually corrected, if additional information on them is available.

Using the IntelligentScan technology, R-Studio can recover files not only on new and existing partitions. It also can find and recover data on partitions that have been deleted or reformatted. If, for example, there was an NTFS partition, which later was reformatted as a FAT partition, R-Studio will show two partitions on the same place on the disk, one having the FAT file system, the other the NTFS. Then, found files can be recovered.

The IntelligentScan technology makes R-Studio a very powerful data recovery tool, but it is not omnipotent. As it uses probabilistic approach to data reconstruction, it cannot guarantee 100% correct results. Moreover, even if R-Studio has reconstructed data structure correctly, it is impossible to guarantee that all found files will be completely and correctly recovered, as new data may be already written over the old files.

### 4.2 Data Recovery Issues

**Files:**

**Hard links**

Hard links are file system entries that give file names to files. This term is usually used when files may have several names. R-Studio shows hard links using the following icons:

A hard link: ![Hard link](image)

The target file: ![Target file](image)

You may find a target or hard link for a file. Right-click the file and select **Links** on the context menu.

### 4.3 Data Formats and Multipliers

You may enter data in all numerical fields either in sectors or in bytes. If there is no letters are after the number, R-Linux assumes the numbers are in bytes.

Decimal numbers are entered as they are: 2372354

Hexadecimal numbers are entered as 0x23Fa67 or 23Fa67 hex.

The following case-insensitive notation is possible:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>1 byte</td>
</tr>
<tr>
<td>kb</td>
<td>1 kb = 2^10 = 1024 bytes</td>
</tr>
<tr>
<td>mb</td>
<td>1 mb = 2^20 = 104857 bytes</td>
</tr>
<tr>
<td>gb</td>
<td>1 gb = 2^30 = 1073741824 bytes</td>
</tr>
<tr>
<td>tb</td>
<td>1 tb = 2^40 = 1099511627776 bytes</td>
</tr>
<tr>
<td>eb</td>
<td>1 eb = 2^50 = 1125899906842624 bytes</td>
</tr>
<tr>
<td>hex</td>
<td>A hexadecimal number</td>
</tr>
<tr>
<td>sec (sector)</td>
<td>A number is in sectors</td>
</tr>
</tbody>
</table>

You may also select the multipliers in the drop-down boxes.
Type an offset to which you want to go. You may select between bytes and sectors. See the Data Formats and Multipliers topic for more details on data formats.

When the multiplier has been changed, the data value will be changed according to the specific context commands for that field:

Suppose, the initial value is 1 GB, and the sector size of the object is 512 byte. The results will be the following:

**Command: No recalculate**
Change from GB to MB: 1
Change from GB to Sectors: 1

**Command: Always recalculate**
Change from GB to MB: 1024
Change from GB to Sectors: 2097152

**Command: Units type recalculate**
Change from GB to MB: 1
Change from GB to Sectors: 2097152

### 4.4 Bad Sectors

Quite often, drives from which the data are to be recovered have bad sectors, or those sectors that are very hard, even impossible, to read, mostly due to hardware problems. R-Linux tries to read such sectors several times. The number of tries is specified either on the Settings/Bad Sectors dialog box, or on the Properties tab, the Drive Control section, for each drive separately.

When R-Linux encounters such bad sectors while performing various tasks and they appear unreadable, it treats them as follows:

**Object images:**
R-Linux fills the space in the image file where the bad sectors should be with the pattern specified in the Pattern to fill bad blocks field on the Settings/Bad Sectors dialog box. Please note that R-Linux writes the pattern on the image, not on the source drive.

**Files**
If Skip files with bad sectors on the Recovery dialog box is cleared, R-Linux fills bad sectors in the recovered file with the pattern specified on the Settings/Bad Sectors dialog box. Information about such files will appear in the Log.

If Skip files with bad sectors on the Recovery dialog box is selected, R-Linux skips files with bad sectors and displays their list on the Files with bad sectors dialog box when the recovery has been completed. You may select files to immediately recover them or to mark for later recovery. You may also save this list to a text file.
Files with bad sectors dialog box

![Files with bad sectors dialog box image]

- **Select All**
  - Click this button to select all files in the list.

- **Clear All**
  - Click this button to unselect all selected files.

- **Mark**
  - Click this button to mark all selected files in the list.

- **Save to File**
  - Click this button to save the list of files with bad sectors to a text file.

- **Recover**
  - Click this button to immediately recover selected files. The bad sectors in the recovered files will be filled with the pattern specified in the Pattern to fill bad blocks field on the **Settings/Bad Sectors** dialog box.

**Objects edited in the Text/Hexadecimal Viewer**

Bad sectors in the objects viewed in the **Text/Hexadecimal Viewer** are shown as filled with the pattern specified in the Pattern to fill bad blocks field on the **Settings/Bad Sectors** dialog box.

### 4.5 Memory Usage

You may see how much memory **R-Linux** uses while performing a data recovery task. This is especially useful when scanning large disks on a computer with limited resources.

**To view memory usage,**

1. Select Memory usage on the Tools menu

   - **R-Linux** will show the total memory in your computer and how much memory it uses

**Memory usage dialog box**

![Memory usage dialog box image]

- **Process Memory**
  - Shows how much memory **R-Linux** uses. Limit shows how much memory your system can virtually allocate to **R-Linux**. Actual memory allocation depends also on the RAM and swap file sizes.

- **System Memory Physical**
  - Shows how much RAM is in your system

- **System Memory Swap**
  - Shows how much virtual memory is in your system
### 4.6 R-Linux Switches

If there are problems in starting R-Linux and while working with it, you may use switches to avoid them.

The following switches are available:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-all_drives</td>
<td>Forces R-Linux to show all partitions in the system. Normally R-Linux shows only local disks in the system. Some storage devices may pretend that they are not local disks.</td>
</tr>
<tr>
<td>-debug</td>
<td>Includes additional debug information. When this switch is used, an additional command Create FS Snapshot on the context menu appears for an object with a file system. An FS Snapshot contains system data for the file system only (file descriptions without file contents). If a problem appears, this snapshot can be sent to R-Linux technical support to identify the problem. This switch greatly slows R-Linux. You may also turn this mode on by selecting Debug Mode on the Tools menu.</td>
</tr>
<tr>
<td>-flush</td>
<td>Flushes the log file after each write to log operations. This switch is helpful when R-Linux locks and its log file remains in memory cache unwritten to a disk. This switch greatly slows R-Linux.</td>
</tr>
<tr>
<td>-log &lt;filename&gt;</td>
<td>Started with this switch, R-Linux writes its log into the specified file. If R-Linux locks and its log file remains in memory cache unwritten to a disk, use the -flush switch.</td>
</tr>
<tr>
<td>-mem &lt;size in MB&gt;</td>
<td>Sets memory usage limit in MB for R-Linux to reconstruct the file tree. When it exceeds the limit, a Too many files... message appears. You may temporarily stop file listing and browse through found files. Then you can resume file listing. You also may skip this file section and continue file listing. Example: -mem 400 - sets the limit to 400 MB.</td>
</tr>
<tr>
<td>-no_ide_ext</td>
<td>Turns off the inquiry about extended information on HDDs in Wind9x/ME. This switch may be helpful if R-Linux returns information about HDDs incorrectly (detects HDD geometry incorrectly).</td>
</tr>
<tr>
<td>-no_int13</td>
<td>Turns off the disc access through Int13 in Wind9x/ME. This switch may be helpful if the system operates incorrectly (detects HDD geometry incorrectly or lock the system).</td>
</tr>
<tr>
<td>-no_ios</td>
<td>Turns off the Wind9x/ME protected-mode I/O system. This switch may be helpful if this system operates incorrectly (detects HDD geometry incorrectly or lock the system).</td>
</tr>
<tr>
<td>-reset</td>
<td>R-Linux resets an HDD controller each time it reads a bad sector. This switch may be helpful if the controller locks after it attempts to read a bad sector, or returns incorrect data.</td>
</tr>
<tr>
<td>-safe</td>
<td>Disables automatic partition search on a hard drive, file system recognition on partitions, and other potentially problematic operations. In this mode, it is necessary to use Find partition command from the hard drive context menu to manually find a partition.</td>
</tr>
</tbody>
</table>

If an unrecognized problem appears, start R-Linux with the -debug and -log <filename> switches, and send the log and screenshot of the R-Linux main panel to the R-Linux technical support:
**R-Linux Technical Support Team** is available 24 hours a day, seven days a week, and has an average response time less than 4 hours.

### 4.7 Properties Tab

**Object size units**
You may select the units in which the information on object sizes will be displayed.

**To select the units**
1. Select Properties on the View menu
2. Select the units in which you want to see object sizes.
   - You may select
     - Show as Bytes
     - Show as Sectors
     - Show as Bytes and Sectors

#### 1. Basic information
This section shows basic information for a disk object.

- **Drive Type**: Device/disk type and subtype. Current **R-Linux** version supports the following types:
  - Disk, WORM, CDROM, Optical, Changer, Floppy, RAM Disk, LDM Partition, LDM Component, LDM Volume
  - and subtypes:
    - Device, OS File, Physical Drive, Mount Point, Partition, Volume Set, Mirror, Stripe Set, RAID5

- **Name**: Device/disk name

- **Size**: Device/disk size

- **Bus Type**: Device/disk bus type. Can be:
  - IDE/ATA, IDE/ATAPI, SCSI, Floppy, USB, 1394, SSA, FibreChannel, RAID, SMART, ABIOS

#### 2. Information on hard drives and logical disks
This section shows available information on hard drives and logical disks. These properties depend on the drive/disk type and appear only when applicable. Under Windows NT/2000/XP/2003, an IDE drive/disk may be represented as a SCSI device, that is why the **SCSI Address** section appears under these OSes for those drives/disks.

- **OS object**: Appears for image files under Windows 9x/ME and NT/2000/XP/2003, for drives/disks under Windows NT/2000/XP/2003 only. An object name used by OS to access the device/disk.

- **R-Studio driver**: Driver names (both internal and OS) used to access this drive/disk.

- **Sector Size**: Drive/disk sector size

- **Physical Drive Geometry**: This section shows physical geometry for a hard drive. For a logical disk it shows the physical geometry for a hard drive where the logical disk resides.
### Device Identification

This section shows vendor information for the drive/disk

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Product</th>
<th>Firmware</th>
<th>Bus</th>
</tr>
</thead>
</table>

### SCSI Address

This section shows SCSI information for the drive/disk

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Path ID</th>
<th>Target ID</th>
<th>Lun</th>
</tr>
</thead>
</table>

**Windows 9x/ME adds the following properties:**

<table>
<thead>
<tr>
<th>Int13 Drive Number</th>
<th>128 for the first hard drive accessible through Int13, 129 for the second one, etc. 0...128 for drives and other devices accessible through a Windows 9x/ME protected mode driver, if their Int13 device option is disabled. <strong>R-Linux</strong> can use Int13 disk access, and for some drive types, like SCSI devices, Int13 access is preferable. You may consider enabling the Int13 device option in the Windows Device Manager for such devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int13 Extension Version</td>
<td>Int13 Extension Version Support for hard drives. Extended Int13 support is necessary for large drives. If this property is zero, Extended Int13 is not supported, otherwise, it shows Extended Int13 standard version, the large, the better.</td>
</tr>
</tbody>
</table>

### Properties controlling access to hard drives and logical disks

This section shows properties that control access (read and write) to hard drives and logical disks. They are set to their optimal values and should be altered only if access problems appear.

#### Drive Control

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum transfer</td>
<td>Maximum data size that can be read or written during a single access to the drive. If there are problems with drive access, decrease the value of this property</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>Data size read or written during a single access to the drive is a multiple value of this property. If there are problems with drive access, decrease the value of this property</td>
</tr>
<tr>
<td>Buffer Alignment</td>
<td>Drive data transfer buffer is positioned at an address multiple value of this property. If there are problems with drive access, increase the value of this property</td>
</tr>
</tbody>
</table>

These three properties are set by OS drivers. If the drivers set incorrect values, problems may appear during data transfer operations. You can alter them until data transfer becomes stable.
I/O Tries

Number of read/write tries during access to the drive. If there are bad sectors on the drive, increase the value of this property. This may help to successfully read those sectors. Sometimes, if the I/O Tries parameter is set too large and there are some unreadable sectors on the hard drive, the hard drive-controller pair may refuse to perform any successive read/write operations with the entire hard drive when it fails to read/write such sectors. In this case, set this parameter to zero. 

R-Linux treats bad sectors in the following way:

It reads a certain part of disk (predefined by Windows) and

- If Default read attempts is set to 0, the entire part with bad sectors will be filled with the specified pattern.
- If Default read attempts is set to a non-zero value, R-Linux reads again that part sector by sector, repeating the attempts the specified number of times. If R-Linux still cannot read a bad sector, it fills the sectors with the specified pattern. In this case only the bad sectors will be filled with the pattern, but that extremely slows the disk read process.

For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

4. Partition properties

A partition is a continuous area on a hard drive, characterized by its offset and size. There are partitions on basic disks, dynamic disks, and recognized volumes and partitions. R-Linux treats regions like partitions.

**More information...**

<table>
<thead>
<tr>
<th>Partition Offset</th>
<th>Initial offset for the partition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition Size</td>
<td>Size of the partition.</td>
</tr>
<tr>
<td>Partition Type</td>
<td>File system type for the partition. If the record in the drive partition table is incorrect, this property may differ from the actual file system type for this partition. Still, R-Linux will process this partition correctly, as it does not use this property.</td>
</tr>
<tr>
<td>Partition number</td>
<td>Appears under WinNT/2000/XP/2003 only. Shows the number of the partition on the physical drive.</td>
</tr>
</tbody>
</table>

For regions and recognized partitions, Partition Offset and Partition Type properties can be manually corrected.

5. Compound volume properties

A compound volume is a union of several partitions or other disk objects. Each union type has its own rules, unique for each compound volume type. Among compound volumes are: Volume Sets (RAIDs Level 0), Mirrors (RAIDs Level 1), RAIDx5 (RAIDs Level 5), both physical and created by the user (Virtual Volume Sets, Virtual Stripe Sets, Virtual Mirrors, Virtual RAID5).

**More information...**

Main properties of compound volumes are parents (disk objects from which a compound volume is created) and their order. These properties may be viewed in the Parents tab. For user-created compound volumes these properties may be altered.

| Raid Block Size | Data block size for compound volumes of RAID (Level 0-5) types |
6. LDM disks and volumes (Dynamic Disks)

*LDM disks and volumes* are volumes controlled by Logical Disk Manager (LDM). They are represented on a hard drive as a LDM database rather than partition tables. Under Windows 2000/XP/2003, LDM disks are also called *Dynamic Disks*.

More information...

<table>
<thead>
<tr>
<th>Offset of Logical Disk</th>
<th>Initial offset of a logical disk on a hard drive. For disks, initially formatted by LDM, this value is often 31.5KB, for converted disks, it may be larger.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supposed Parents Count</td>
<td>Supposed number of parent partitions for compound LDM volumes. If the LDM database is not damaged, the value of this property must be equal to the number of parent objects in the <em>Parents</em> tab for the disk object.</td>
</tr>
<tr>
<td>LDM Host GUID</td>
<td>Global Unique Identifier of a computer system where this LDM disk group has been created.</td>
</tr>
<tr>
<td>LDM DiskGroup GUID</td>
<td>Global Unique Identifier of the LDM disk group.</td>
</tr>
<tr>
<td>LDM Disk GUID</td>
<td>Global Unique Identifier of the hard drive.</td>
</tr>
<tr>
<td>LDM Volume GUID</td>
<td>Global Unique Identifier of the volume.</td>
</tr>
<tr>
<td>LDM Disk ID</td>
<td>Local hard drive Identifier, unique within this LDM disk group.</td>
</tr>
<tr>
<td>LDM Partition ID</td>
<td>Local partition Identifier, unique within this LDM disk group.</td>
</tr>
<tr>
<td>LDM Component ID</td>
<td>Local component Identifier, unique within this LDM disk group.</td>
</tr>
<tr>
<td>LDM Volume ID</td>
<td>Local volume Identifier, unique within this LDM disk group.</td>
</tr>
<tr>
<td>LDM Disk AltName</td>
<td>Additional Alternative Name given by LDM to the hard drive.</td>
</tr>
<tr>
<td>LDM Disk DriveHint</td>
<td>Last name of the volume, under which it has been mounted in the system. May be either a letter (C:, D:, etc.), or a mount point under Windows 2000/XP/2003.</td>
</tr>
</tbody>
</table>

7. File System Volume properties

A *File System (FS) volume* is a disk object where a certain, supported by R-Linux, file system is present. There are two FS volume types: FS volume on a regular disk object and a recognized volume, found by a scan process. FS volume properties depend on volume’s file system and type.

7.1. NTFS Volume properties

These properties are present for all NTFS volumes and represent their main properties. For *recognized volumes*, these values can be altered.

More information...

<table>
<thead>
<tr>
<th>NTFS Information</th>
<th>Regular volumes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recognized NTFS</td>
<td>Recognized volumes</td>
</tr>
<tr>
<td>Cluster Size</td>
<td>Cluster size for the NTFS volume.</td>
</tr>
<tr>
<td>MFT record size</td>
<td>Size of one MFT record describing one file on the NTFS volume. This is an important property of any NTFS volume. Its common value is 1KB. If this property has incorrect value, many files may be incorrectly recovered.</td>
</tr>
<tr>
<td>Sector Size</td>
<td>Sector size for the physical drive. This property is read from the boot sector of the NTFS volume and does not affect R-Linux operation.</td>
</tr>
</tbody>
</table>
### Index Block Size
Index block size for the NTFS volume. This property determines binary trees used to store NTFS folder structure. It does not affect R-Linux operation.

### MFT position
MFT offset from the start of the NTFS volume.

### MFT Mirror Position
Second MFT copy offset from the start of the NTFS volume.

### Volume size
Size of the NTFS volume. This property does not affect R-Linux operation.

## 7.2. FAT Volume properties
These properties are present for all FAT volumes and represent their main properties. For recognized volumes, these values can be altered.

- **FAT Information**
  - Regular volumes

- **Recognized FAT**
  - Recognized volumes

- **FAT Bits (12,16,32)**
  - FAT type. 12 for the FAT12, 16 for the FAT16, 32 for the FAT32.

- **Cluster Size**
  - Cluster size for the FAT volume.

- **First Cluster Offset**
  - Offset of the first cluster from the start of the FAT volume.

- **Boot Directory Cluster**
  - (For FAT32 only.) Cluster number where the root directory starts on the FAT volume where the logical disk resides.

- **Root Directory Offset**
  - (For FAT12 and 16 only.) Root directory offset from the start of the FAT volume.

- **Root Directory Length**
  - (For FAT12 and 16 only.) Root directory length for the FAT volume.

- **First FAT Offset**
  - Offset for the first FAT table on the volume. Together with the Size of One Fat Table property, is a most important property for a FAT volume. If this property is incorrect, many files (especially fragmented ones) may be incorrectly recovered.

- **Size of One FAT Table**
  - Size of one FAT table on the volume.

- **Sector Size**
  - Sector size of the hard drive. This property is read from the boot sector of the FAT volume and does not affect R-Linux operation.

- **Number of FAT Copies**
  - Number of FAT copies on the FAT volume.

- **Active FAT copy**
  - Active FAT table number for the FAT volume. Can be set to Disabled, Auto, 1, or 2. If it is Disabled, R-Linux processes the volume as there is no FAT table present. This may be useful if the volume has been reformatted and thus a new FAT table is created and the old one is deleted. In this case, it is reasonable to recover files from the previous volume without processing the new and irrelevant FAT table. All files will be recovered as continuous byte chains beginning from their start cluster. Unfragmented files will be recovered successfully. If it is 1 or 2, R-Linux uses the first or second FAT table copy, respectively. If it is Auto, R-Linux uses both FAT table copies and decides, which FAT table copy should be used for a particular FAT table sector. This may be useful when both FAT tables are partially damaged.

- **Major version**
  - FAT version.
### 7.3. Ext2/3/4FS Volume properties

These properties are present for all Ext2/3/4FS volumes and represent their main properties. For recognized volumes, these values can be altered.

<table>
<thead>
<tr>
<th>Minor version</th>
<th>FAT minor version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume size</td>
<td>Size of the volume.</td>
</tr>
</tbody>
</table>

#### More information...

<table>
<thead>
<tr>
<th>Ext2/3/4FS Information</th>
<th>Regular volumes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recognized Ext2/3/4FS</td>
<td>Recognized volumes</td>
</tr>
<tr>
<td>Block Size</td>
<td>Block size of Ext2/3/4FS file system. A block in the Ext2/3/4FS file system is similar to a cluster in the FAT file system.</td>
</tr>
<tr>
<td>First SuperBlock Offset</td>
<td>Offset of the first SuperBlock from the start of the Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>Blocks Per Volume</td>
<td>Number of blocks in the Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>INodes Per Volume</td>
<td>Number of inodes on the Ext2/3/4FS volume. An inode is a record describing file's size, attributes, position on an Ext2/3/4FS volume - all information about a file, except its name, which is stored separately. Therefore, the INodes Per Volume parameter is equal to the maximum number of files on an Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>Creator OS</td>
<td>The OS that created this Ext2/3/4FS volume. May be Linux, Hurd, Masix, FreeBSD, Lites.</td>
</tr>
<tr>
<td>Minor version</td>
<td>Ext2/3/4FS minor version. Usually 0.</td>
</tr>
<tr>
<td>Last Mount Time</td>
<td>Last mount time for this Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>Last Write Time</td>
<td>Last write time for this Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>Last Check Time</td>
<td>Last check time for this Ext2/3/4FS volume.</td>
</tr>
<tr>
<td>Volume size</td>
<td>Size of the volume.</td>
</tr>
</tbody>
</table>

### 7.4. Recognized Volume properties

These properties are present for all recognized volumes, regardless of their file system type. They estimate how reliable those volumes are recognized. This is useful for fast search for, and selection of, optimally recognized volume to recover.

#### More information...

<table>
<thead>
<tr>
<th>Parsed File Entries</th>
<th>Number of files proving that this recognized volume existed. May have any non-negative values. The main property characterizing the reliability of volume recognition. The larger it, the higher probability that this recognized volume has file system properties that have been correctly found.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parsed Boot Records</td>
<td>Number of boot records proving that this recognized volume existed. May be 0 or 1. This is the second important property characterizing the reliability of volume recognition.</td>
</tr>
<tr>
<td>Estimated Size</td>
<td>Estimated size of the recognized FS partition/volume. This property shows the most probable size of the recognized FS partition/volume. Alternatively, Size and Partition Size are set to the highest possible values in order to recover the maximum number of files.</td>
</tr>
</tbody>
</table>
Index

- A -

Advanced Data Recovery  38

- B -

Bad Sectors  72
Bad Sectors settings
  Default read retries  11
  Pattern to fill bad blocks  11
  Set for all drives  11
Basic File Recovery  17
Broken File Name
  Prompt:  55
  Rename and change all invalid symbols to:  55
Broken File Name options
  Change all invalid symbols to  17
  Edit broken symbols only  17
  File name  17
  New name  17
Button
  Clear All  72
  Mark  72
  Recover  72
  Save to File  72
  Select All  72
Buttons
  Add  38
  Advanced  38
  Code pages  61
  Create Image  6, 49
  Create Region  6, 46
  Delete  6
  File Mask  36
  Find Next  26
  Find Previous  26
  Find/Mark  26
  Go!  65
  Known File Types  38
  Next Pattern  61
  OK  65
  Open Drive Files  6
  Open Image  6, 49
  Open in Hex Editor  38
  Preview  29
  Previous Pattern  61
  Recover  17
  Recover Marked  17
  Refresh  6
  Rename  17
  Rename All  17
  Reset  38
  Save Changes  61
  Scan  6, 38
  Show Files  17
  Skip  17
  Skip All  17
  Stop  6

- C -

Contact information and technical support  5
Context menu
  Add missing disks  58
  Always recalculate  71
  Clear Log...  37
  Close drive  25
  Copy as "ANSI"  68
  Copy as "Binary data"  68
  Copy as "UNICODE"  68
  Copy as File Signature  68
  Copy Editor Display  68
  Create Exclusive Region  47
  Create Image File  49
  Create Region  46
  Delete All Scanned Information  38
  Delete Region  46
  Edit  47
  File mask  36
  Find Next  26
  Find Previous  26
  Find Previous Versions of the File  28
  Find Template Signature Next  61
  Find Template Signature Previous  61
  Find/Mark  26
  Log Filter...  37
  Mark  17
  Mark All  17
  Merge Down  38
  Merge Down All  38
  Merge Selected  38
Context menu
  No recalculate  71
  Open Drive Files Sorted By  54
  Open Scan Information  38
  Preview  29
  Real File System Structure  54
  Recover  17
  Recover All Files  53
  Recover Marked  17
  Save Log to File...  37
  Save Scan Information  38
  Scan  38
  Show Files  17
  Show Files In Tab  25
  Toggle Bookmark  61
  Units type recalculate  71
  Unmark  17
  Unmark All  17
  View/Edit  61

Create menu
  Create Exclusive Region  47
  Create Region  46

- D -
Data Copy in Text/hexadecimal viewer  68
Data Formats and Multipliers  71
Data Recovery Using R-Linux  16

Dialog boxes
  Broken File Name  17
  Create Exclusive Region  47
  Create Region  46
  File mask  36
  File Types  38
  Files with bad sectors  72
  Fill  61
  Find/Mark  26
  Go to  61, 65
  Go To Offset  65
  Memory Usage  73
  Recover  17, 53, 55
  Scan  38
  Scan Information  38
  Search  61, 65
  Settings  11

Disk scan  6, 38

Drive menu
  Create Image  49

Delete Scan Information  38
Open Drive Files  17
Open Drive Files Sorted By  54
Open Image File  49
Open Scan Information  38
Real File System Structure  54
Recover All Files  53
Save Scan Information  38
Scan  38

- E -
Edit menu
  Bookmarks  61, 65
  Find  61, 65
  Find Next  61, 65
  Find Previous  61, 65
  Find Template Signature Next  61
  Find Template Signature Previous  61

Event log  37
Exclusive Region  47
Exclusive Region options
  Offset  47
  Start  47

Exclusive Regions  47

- F -
File Already Exists
  Overwrite  55
  Overwrite Bigger  55
  Overwrite Older  55
  Overwrite Smaller  55
  Prompt  55
  Rename  55
  Skip  55

File mask options
  Date  36
  Deleted files  36
  Existing files  36
  Match case  36
  Show empty folders  36
  Size from/up to  36

File masks  36

File menu
  Close All Previews  29
  Preview  29
File menu
- Recover 17
- Recover Marked 17
- Show Files in Hex viewer 69
- View 61

File search 6

File Systems settings
- Default encoding for Ext2/Ext3/Ext4/UFS volumes 11
- Default encoding for HFS volumes 11
- Disable any sorting 11
- Minimize disk access 11
- Show deleted empty folders 11

File Types
- Clear All 38
- Reload User's File Types 38
- Reset to Recommended 38
- Revert to Default 38
- Select All 38
- Set as Default 38

Files and Sectors 69

Find and Mark Multiple Files 54

Find options
- Date 26
- Deleted files 26
- Direction 26
- Existing files 26
- File Id 26
- Files 26
- Find/Mark mode 26
- Folders 26
- Look in 26
- Match case 26
- Regular expression 26
- Size from/up to 26

Finding Previous File Versions 28

- H -

Help menu
- Disable All Hints 6
- Show All Hints 6

- I -

Image 49

Image options

Compressed image (R-Drive Image compatible) 49
- Estimated size 49
- Image name 49
- Image split size 49
- Password 49
- Pattern to fill bad blocks 49
- Plain image 49
- Read attempts 49

IntelligentScan Technology 70

Introduction to R-Linux 1

- L -

Linux LVM 58
- Linux mdadm RAIDs 57

Log settings
- Disk 11
- Error 11
- File name 11
- File System 11
- Files 11
- Information 11
- Maximum messages in the Event Log 11
- Network 11
- Partition 11
- Recover 11
- Save log to file 11
- Success 11
- Warning 11

- M -

Main settings
- Debug Mode 11
- Reset all hidden notifications 11
- User's file mask presets 11

Mass file recovery 53

Mass File Recovery Options 55

Memory Usage 73
- Process Memory 73
- System Memory Physical 73
- System Memory Swap 73

Messages
- Double-click a logical disk... 17
- Too many files... 17, 53, 74
- O -

Opening several disks/partitions in one tab 25

- P -

Panels
   Files 17
   Folders 17
   Log 17, 37
   Main 6

Panes
   Bookmarks 61
   Data Interpreter 61
   Find Results 61
   Template 61

Previewing files 29

Properties tab
   Active FAT copy 75
   Block Size 75
   Blocks Per Volume 75
   Boot Directory Cluster 75
   Buffer Alignment 75
   Bus Type 75
   Cluster size 75
   Creator OS 75
   Device Identification 75
   Drive Control 75
   Drive Type 75
   Estimated Size 75
   Ext2/3/4FS Information 75
   Fat Bits (12,16,32) 75
   FAT Information 75
   First Cluster Offset 75
   First FAT Offset 75
   First SuperBlock Offset 75
   I/O Tries 75
   I/O Unit 75
   Index Block Size 75
   INodes Per Volume 75
   Int13 Drive Number 75
   Int13 Extension Version 75
   Last Check Time 75
   Last Mount Time 75
   Last Write Time 75
   LDM Component ID 75
   LDM Disk AltName 75
   LDM Disk DriveHint 75
   LDM Disk GUID 75
   LDM Disk ID 75
   LDM DiskGroup GUID 75
   LDM Host GUID 75
   LDM Partition ID 75
   LDM Volume GUID 75
   LDM Volume ID 75
   Major version 75
   Maximum transfer 75
   MFT Mirror Position 75
   MFT position 75
   MFT record size 75
   Minor version 75
   Name 75
   NTFS Information 75
   Number of FAT Copies 75
   Offset of Logical Disk 75
   OS object 75
   Parsed Boot Records 75
   Parsed File Entries 75
   Partition number 75
   Partition Offset 75
   Partition Size 75
   Partition Type 75
   Physical Drive Geometry 75
   Raid Block Size 75
   Recognized Ext2/3/4FS 75
   Recognized FAT 75
   Recognized NTFS 75
   Root Directory Length 75
   Root Directory Offset 75
   R-Studio driver 75
   SCSI Address 75
   Sector Size 75
   Size 75
   Size of One FAT Table 75
   Supposed Parents Count 75
   Volume size 75

- R -

Recover options
   Condense successful restoration events: 17
   Ignore file mask: 17
   Recover alternative data streams: 17
   Recover metafiles 17
Recover options
  Recover security: 17
  Remove hidden attributes 17
  Restore folder structure: 17
  Restore from root 17
Region 46
Region options
  Disk size 46
  Size 46
  Start 46
Regular expressions 37
R-Linux switches 74
R-Studio features 2

- S -
Scan options
  Disk size 38
  File Systems 38
  Offset 38
  Save to File 38
  Scan Areas 38
  Size 38
  Start 38
Search options
  ANSI 61, 65
  Exhaustive search 61, 65
  From Address 61, 65
  From current position 61, 65
  From start position 65
  HEX 61, 65
  Match case 61, 65
  Not Equal 65
  OEM 61, 65
  Reverse 61, 65
  Search at offset 61, 65
  UNICODE 61, 65
Searching for a File 26
Settings
  Bad Sectors 11
  File Systems settings 11
  Known File Types 11
  Log 11
  Main 11

- T -
Tabs
  Properties 75
Technical Information and Troubleshooting 70
Text/hexadecimal viewer 60
  Allocation 61
  ANSI/OEM/UNICODE/UNICODE+ 61
  Direct 61
  Save to Hexadecimal File 61
  Std 61
  Unlimited 61
Tools menu
  Debug Mode 74
  File mask 36
  Find 26
  Find All 26
  Find Next 26
  Find Previous 26
  Goto 61
  Mark All 17
  Save to Binary File... 61
  Save to Hexadecimal File 61
  Select All 61
  Settings 11
  Unmark All 17

- V -
Various Disk and Volume Managers 57
View menu
  ANSI 61
  Arrange 17
  Bookmarks View 61
  Data Interpreter View 61
  Details 17
  Device View 6
  Event Log 6, 17
  Files panel 17
  Folders panel 17
  OEM 61
  Parents Tab 6
  Properties 6, 75
  Properties Tab 6
  Properties View 6, 61
  Scan Information Tab 6
View menu
  Sectors View  61
  Status bar   6, 17
  Template View 61
  Toolbar      6, 17, 61
  UNICODE      61
  UNICODE+     61